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Preface

Welcome to the Oracle Sales Compensation, Release 11i, suite of applications.

This Implementation Guide provides information and instructions to help you work 
effectively with Oracle Sales Compensation.

This preface explains how this Implementation Guide is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

� Sales Compensation managers, analysts, and salespeople tasked with 
implementing and using Oracle Sales Compensation.

Related Documents
For more information, see the following manuals:

� Oracle Applications, Product Update Notes, Release 11i (A85297-01)

� Installing Oracle Applications, Release 11i (A87333-01)

� Oracle Applications Release 11i Concepts (A82932-01)

� Implementing CRM Applications (A86291-01)

� Oracle CRM Foundation Components Concepts and Procedures (A86099-01)

� Oracle CRM Foundation Technical Reference Manual (A86150-01)
ix



� Oracle CRM Foundation Implementation Guide (A86122-01)

� Implementing Oracle CRM:ERP Functional Checklist (available on Oracle 
MetaLink)

� Implementing Oracle CRM Functional Checklist (available on Oracle MetaLink)

� Oracle Sales Online Technical Reference Manual (A86175-01)

� Oracle Sales Compensation Concepts and Procedures (A86673-01)
x



  Implementing Oracle Sales Compensation

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle Sales Compensation Concepts and Procedures

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

Overview of Oracle Sales Compensation
Using Oracle Sales Compensation you can automate the complex task of calculating 
compensation and customize compensation to suit the unique operations of your 
organization’s sales force. 

Because sales tasks vary highly from one company to another, a compensation 
system that produces windfall sales for one company might not suit another. Oracle 
Sales Compensation calculates and assigns compensation based on functions that 
precisely mirror the operations of your sales organization. For example, you can:

� Define the structure of a compensation transaction, or the set of information 
your sales organization needs to calculate sales compensation.
Implementing Oracle Sales Compensation 1



Navigation
You specify the data you need, and Oracle Sales Compensation then collects this 
data for you from the data sources you specify.

� Categorize your business revenue into revenue classes that specify the types of 
revenue that warrant compensation in your organization. 

Oracle Sales Compensation assigns a revenue class to a compensation 
transaction using a set of classification conditions you define for each class. You 
can pay a salesperson for certain revenue classes but not for others because 
Oracle Sales Compensation only awards credit based on the revenue classes you 
assign to a salesperson’s compensation plan.

� Define an unlimited number of compensation plans and assign them to 
individuals or groups of salespeople.

You can compensate many different kinds of salespeople by mixing and 
matching compensation terms when you build each plan.

� Define how your organization tracks and pays incentive compensation.

� Specify how your organization typically makes adjustments.

After you define precisely how your sales force operates, you generate your own 
customized version of the system from which to pay sales compensation. You can 
respond to changing sales strategies by making changes in your setup and 
regenerating the system.

Navigation
The navigator displays:

� Icon that represents each functional area

� Drop-down list of views relating to each functional area

� Hierarchical list of functions that relates to the selected view

� Nodes in each hierarchy representing each related record in the database

Choose the functional area and choose a view. Double-click a node to expand the 
hierarchy. Double-click a data node to open the functional window and display the 
selected record.

Right-click a node to perform any of the following actions:

� Add a new item below the selected node

� Open the selected functional window
2 Oracle Sales Compensation Implementation Guide



System Integration
� Conduct a search

� Copy the selected node

� Refresh the list

System Integration 
Oracle Sales Compensation integrates with other applications in the Oracle 
e-business suite to optimize the powerful functions of the product. Interface 
programs systematically link two or more systems to each other. With Oracle Sales 
Compensation and custom interfaces, you can accomplish some of the critical tasks 
of a sales compensation process:

� Collect sales transaction data from Oracle Receivables, Oracle Order Capture, 
and other sources

� Pay compensation through payroll (internal employees) or an accounts payable 
(internal or external people and groups) system

� Maintain sales roles and compensation groups

� Maintain salespeople information

� Generate reports (see samples reports in the appendix of this Guide) related to 
compensation and other useful sales benchmarks

As a customization, you can create multiple interfaces, referred to as application 
programing interfaces (APIs), to bring transactions into Oracle Sales Compensation 
and to send transactions out to other systems. Oracle Sales Compensation 
transactions can originate from a sales order, a customer billing, a customer 
payment, or other business functions. 

Overview
Oracle Sales Compensation exchanges information with other products within the 
Oracle e-business suite. Transactions, the raw material that fuels the Oracle Sales 
Compensation, are primarily derived from Oracle Receivables and Order Capture 
or Order Management. 

Oracle Receivables and Oracle Order Capture provide sales transaction information 
that forms the basis for calculating sales compensation.

Examples of the types of transaction data Oracle Receivables can provide include: 

� Invoices
Implementing Oracle Sales Compensation 3



System Integration
� Credit and debit memos

� Payment postings

� Write-off postings

� Take-back postings, which are generated when an invoice due date goes 
beyond the set grace period. The credit for the sale is deducted from the 
salesperson’s sales credit.

� Give-back postings which are generated when a past due invoice that has 
been deducted from the salesperson’s sales credit is paid. The salesperson 
receives the credit.

From Oracle Order Capture, you can collect booked orders and adjustments to 
booked orders. In release 11i of Oracle Applications, Order Management replaces 
the Order Entry system interface for collecting order information. Oracle Sales 
Compensation, as well as all other applications in the Oracle e-business suite, must 
use the new Order Capture module to interface to Order Management.

Resource Manager is the common source for resource definition, and Oracle Sales 
Compensation ability to read Resource Manager directly eliminates the need to 
create commonly used definitions and relationships in multiple applications. Use 
Resource Manager to

� Create Resources (salespeople)

� Create Sales Roles (formerly known as plan type) and assign salespeople to 
them

� Create Compensation Groups, the basis of Sales hierarchy

In addition to these traditional sources of information, release 11i of Oracle Sales 
Compensation provides two-way integration to applications such as Oracle Sales 
Online, Business Intelligence Systems (BIS), and other applications within the 
e-Business suite. Some examples of this integration include the following:

� Oracle Sales Online provides a sales performance and compensation forecasting 
tool for sales representatives and managers, based on current compensation 
plans. It is also a means for monitoring sales force performance through 
rankings. Salespeople can view their compensation summary and break down 
their commissions by deal, product line, period, adjustments, or transactions. 
They can “blind-rank” themselves to measure their performance against a 
group of peers. They can also use Sales Online to view projected compensation 
based on opportunities they enter into the system or commit to the forecast. 

� Compensation information is made available to Oracle Sales Intelligence.
4 Oracle Sales Compensation Implementation Guide



System Integration
Foundation Modules and Dependencies
CRM Foundation modules are those that build on code shared by applications in 
the Oracle e-Business suite. A foundation module performs the same function in 
many different applications. All foundation modules are provided when any 
e-Business application is purchased. Two foundation modules that are especially 
important to understanding Sales Compensation are Resource Manager and Order 
Capture. 

Order Management is a new module in R11i of Oracle’s e-Business suite. Unlike 
Order Capture, it is a salable product, not a foundation module. However, in the 
event that Order Management is purchased and installed, it serves as the 
mechanism by which Sales Compensation accesses Order Capture information.

Oracle Sales Online
If a manager is required to allocate Quota to his/her Directs, then this manager can 
perform the Quota allocation and Compensation Plan distribution tasks via the 
Compensation tab in Oracle Sales Online screens.

If Salespeople have access to Oracle Sales Online, they can submit their estimate of 
their own Quota and either accept or reject their Compensation Plans when the 
Plans are distributed to them by their manager via Oracle Sales Online.

Please observe the following steps so that managers and salespeople have access to 
the screens under the Compensation tab in Oracle Sales Online. 

Prerequisites
System Administrator responsibility is required.

Steps
1. In the System Administrator Navigator, select Security.

2. Expand the Security menu by double-clicking on Security.

3. Double-click User.

4. Double-click Define.

5. Find the Oracle Sales Online User’s name by enabling this Form in the Query 
mode. From the Menu bar, select View > Query by Example > Enter. (The F11 
key performs the same function.)
Implementing Oracle Sales Compensation 5



Setting Up Resource Manager
6. Enter your User’s name in the User Name field. Start the search from the Menu 
bar by clicking View > Query by Example > Run. (Pressing the Control key and 
the F11 key together performs the same function.)

7. Under the Responsibility column, add a new responsibility by selecting either 
Sales Compensation Manager or Sales Compensation Salesperson 
responsibility.

8. Enter a Start Date against this new responsibility assignment and possibly an 
End Date if you wish to terminate this User’s access to the Compensation tab in 
Oracle Sales Online at a certain point in time in the future.

Setting Up Resource Manager
In addition to the pre-defined Role Types and Role Information, you can define new 
Role Types and Roles. Set up Resource Manager by following these procedures.

Defining Role Types
A Role Type is a category of roles associated with a particular CRM module. Oracle 
Resource Manager is delivered with pre-defined Role Types for all CRM modules. 
Use this procedure to define additional custom Role Types for your enterprise.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Role Types.

The Application Object Library window displays existing Role Types.

2.  Use the down arrow to scroll to the bottom of the list of Role Types.

3.  Enter the name of the new Role Type in the blank field at the bottom of the list.

4.  In the Meaning field, enter the CRM module for which this Role Type is 
created.

5.  Choose File > Save to complete the Role Type definition.

Defining Roles
A Role may encompass one or more job descriptions and job titles. Use Roles to 
assign jobs to resources, resource groups and resource teams. Oracle Resource 
Manager is delivered with pre-defined Roles for all CRM modules. Use this 
procedure to define additional custom Roles for your enterprise.
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Setting Up Resource Manager
Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Roles.

The Roles window displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the 
list of values.

3. Select the Active box to make the Role active. Select one or more of the job title 
boxes–Manager, Member, Admin, Lead–to associate the Role to job titles.

4. Use one or more of the Job lines to describe jobs associated with the Role.

5. Select File > Save to complete the Role definition.

Resource Manager does not use profile options.

Resource Manager does not use Workflow processes.

Reviewing Information and Administering Sales Compensation
A single sale is credited through a hierarchy of salespeople and managers by using 
a structure of compensation groups. Define compensation groups and build 
hierarchies of compensation groups using Groups in Oracle Resource Manager. 
Assign sales roles in the Roles tab and specify Sales Compensation in the Usages tab 
when you define the group. Only then can compensation groups be viewed in 
Oracle Sales Compensation.

To view Compensation Groups, go to Navigator and choose Sales People > View 
By Compensation Groups.

In the expanded hierarchy, right-click a group and choose Open.

The Compensation Groups window displays the selected group.

Use this procedure to review information about a salesperson, assign sales roles and 
payment plans, and administer the salesperson’s compensation.

Prerequisites
The salesperson must be defined.
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Setting Up Resource Manager
Steps
1.  Select a salesperson from the Navigator or query up the salesperson. Go to 

Details.

2. To assign a pay group to a salesperson, in the Salesperson tab use the list of 
values to choose the pay group. Then assign start and end dates.

3. If you want to temporarily withhold payment for this salesperson, then in the 
Compensation tab in Resource Manager select Hold Payment and select a 
reason for the payment hold.

The salesperson’s payment is not generated when the pay group is submitted 
for payment.

4. To reassign a salesperson to a new role, in the Roles tab review the 
salesperson’s assigned sales roles and see compensation groups in the Groups 
tab.

5. To assign a sales role to a person, select the Roles tab. From the list of values   
choose the sales role and then assign start and end dates.

6. To assign a new compensation group, select the Compensation Plans tab. 
Review the salesperson’s assigned compensation plans and plan elements.

7. Optionally, click Compensation Summary or click Compensation Details to 
view the salesperson’s compensation information.

8. In the Payment Plans tab, review the salesperson’s payment plan information.

9. To assign a payment plan, in the Payment Plans tab select the plan from the list 
of values and enter start and end dates.

10.  To pay a salesperson either a minimum or maximum amount regardless of 
commissions earned, then enter the amount.

11. To deduct the minimum payment from later commissions, select Recoverable 
and, optionally, enter a maximum recoverable amount.

12. To assign a commission earned above the maximum payment to a later pay run, 
select Pay Later.

13. Save your changes.

Guidelines
When you enter start and end dates, the dates must fall within the range of effective 
dates for both items being assigned, for example, the salesperson and the sales role.
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Setting Up Resource Manager
A salesperson can be assigned multiple pay groups, but only one pay group can be 
active at a time.

If you want any Salesperson to view his/her Compensation Reports in a 
nonfunctional currency, ensure that you select the Salesperson’s currency in the 
Compensation Currency field on the Compensation tab in Resource Manager. 

Oracle Accounts Payable
Oracle Accounts Payable recognizes Salespeople for payment if they are activated 
as Suppliers through Oracle Purchasing. Please refer to Oracle Purchasing Guides.

When a Payrun has been processed (Paid status against the Payrun name), the 
Salespeople Sub-ledgers are updated to reflect the amounts paid in the appropriate 
accounts and balances. Payrun details would also have been sent to Oracle 
Accounts Payable Invoices Interface Table.

The records in cn_payment_lines_interface Table are mapped to the invoice 
interface in Oracle Accounts Payable. The mapping has been done as follows:

    

AP_INVOICES_INTERFACE Populated with

INVOICE_ID AP_INVOICES_INTERFACE_S.NEXTVAL

INVOICE_NUM CNPD.COMMISSION_LINE_ID

INVOICE_DATE  CN_PAYRUNS.PAY_DATE

VENDOR_ID FND_USER.SUPPLIER_ID

VENDOR_SITE_ID PO_VENDOR_SITES.VENDOR_SITE_ID

INVOICE_AMOUNT COMMISSIONABLE_AMOUNT

INVOICE_CURRENCY_CODE FUNCTIONAL CURRENCY CODE

PAYMENT_CURRENCY_CODE REP CURRENCY CODE

SOURCE “OSC” (NEW quick code of type SOURCE)
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Setting Up Planning Module
The Liability Account will also be mapped to the Oracle Accounts Payable Interface. 
This will be done using the account generator, accessible via the Ruleset Form. 

Setting Up Planning Module

Screen List for Planning Module

AP_INVOICE_LINES_INTERFACE Populated with

INVOICE_ID Same value as entered for AP_INVOICES_INTERFACE

INVOICE_LINE_ID AP_INVOICE_LINES_INTERFACE_S.NEXTVAL

LINE_NUMBER CNPD.COMMISSION_LINE_ID

LINE_TYPE_LOOKUP_CODE ITEM/ TAX / MISCELLANEOUS

AMOUNT CNPD

Tab Subtab Screen name

Salesforce Summary

Salesforce Summary

Salesperson Details

Job Title Details

Sales Role Detail

Salesforce Pay Element Details

Quota Allocate 

My Compensation Groups

Quota Modeling Summary

Quota from Field 

Assign quota

Compensation Plan History

Compensation Plan

Add To-Be-Hired
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Setting Up Planning Module
Salesperson Detail

Approve 

Search and Result screens

Approve Contract

Distribute

Search and Results screens

Distribute Contract

Activate

Search and Results screens

Activate Compensation Plan 

Reports Search and Results screens for each report

Analysis

Summary Analysis Reports

Quota Model Summary

Average Quota Summary

Overassign Quota

Quota Range Summary

Validation 

Summary Validation Reports

Overlay Summary

To-Be-Hired Report

Transitional Salespeople

 Generation 

Summary Generation Reports

Plan Status

Sales Role and Compensation Plan Mapping

Setup

Sales Roles

Tab Subtab Screen name
Implementing Oracle Sales Compensation 11



Setting Up Planning Module
Quota Components
Use this screen to create Components and specify their type.

Components are parts of a Compensation Plan. Examples of Fixed Pay Components 
are Fixed Salary and Car Allowance. Examples of Variable Pay Components for a 
Personal Computer Salesperson at Global Computers are Multimedia PC Sales, 
Professional PC Sales and Maintenance Service.

Prerequisites  
None

Sales Role Summary

Sales Role Detail

Edit Computed Component Formula

Define Quota Anchors

Components

Quota Components

Job Titles  

Job Title Summary

 Job Title Detail

User Access

User Summary

User Access Detail  

Plan Text

Default Contract Text

Activate Roles

Generic Push

Attainment

Attainment Summary

Attainment Details

Tab Subtab Screen name
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Setting Up Planning Module
Steps
1. In the Application, choose Setup > Components.

2. Enter the name of the Component.

3. Enter a short description for each component.

4. Select a Component type.

5. Check the Compute Flag if the value of the component is to be derived from a 
formula.

Guidelines
In the example, the Component names are Fixed Salary, Car Allowance, Multimedia 
PC Sales, Professional PC Sales, Total PC Sales, Maintenance Services, Total Quota.

Component types are either Fixed or Variable. If Variable, select either Quota Based 
or Non Quota Based. In the Vision example, Fixed Salary Component and Car 
Allowance Component are both Fixed type. Multimedia PC Sales Component, 
Professional PC Sales Component and Maintenance Services Component are 
Variable Quota Based type. 

If the Quota for a Component is to be derived from using a formula, then check the 
Compute Flag box. Total PC Sales Component and Total Quota Component are 
Variable Quota Based type as well but with the Compute Flag checked. Example, 
Total PC Sales Component has the Compute Flag checked because its value is the 
sum of the values of Multimedia PC Sales Component and Professional PC Sales 
Component added together. Total Quota Component value is the sum of values of 
Total PC Sales Component and Maintenance Services Component.

Attainment Schedule
The Attainment Schedule will be used in the Compensation Contract where 
earnings for each level of achievement are displayed.

Create your Attainment Schedules under the Setup tab > Attainment.

Sales Role Summary
Use this screen to find a Sales Role.

A Sales Role describes a set of salespeople who share a common compensation 
structure. Examples are PC Salesperson, Education Salesperson, Consultant, and PC 
Regional Sales Manager.
Implementing Oracle Sales Compensation 13



Setting Up Planning Module
Prerequisites
Sales Roles must be created first. If they have not been created, click Create to go to 
the Create Sales Role screen.

Steps
Select a Sales Role name to go to its details.

Sales Role Detail
Use this screen to view and/or edit a Sales Role’s details.

Prerequisites 
Sales Roles, Components, Attainment Schedules, Rate Tables, Single dimension Rate 
Tables must be created in the Production Module.

Steps
1. On Target Earnings: enter Total Earnings if Salesperson achieves 100% of Quota.

2. Club Eligible: check box if this Role is entitled to Club participation on 
achieving Club rules.

3. Rounding factor: for example, input 1000 if Quota figure that will end up on the 
Compensation Plan is to be rounded up to the nearest 1000.

4. Determine minimum and maximum Quotas: enter the range of Quota figures 
that this Role should have.

5. Enter the Compensation Plan Level.

6. Select an Attainment Schedule applicable for this Role’s Compensation Plan.

7. Determine Fixed Pay Components: select Fixed Components and enter 
ascending numbers against each Component to indicate the sequence that each 
Component is to appear in the Assign Quota and Quota From Field Salespeople 
screens. Enter the Fixed Pay Amount for each Fixed Component. (Vision 
example, if the Fixed Salary of a PC Salesperson is 50000, then enter 50000 
against the Fixed Salary Component.

8. Variable Pay Non Computed Components: as above, select Components and 
enter sequential order of display. 

If you want a Plan Element and a basic formula to be created in Production 
Module for you (relating to your selected Component), choose a Formula type, 
Rate Table and enter the new name of your Plan Element. The type of Formula 
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Setting Up Planning Module
is driven by your Rate Table definition (example percentage tiers and 
percentage rates or percentage tiers and amount rates or tiers expressed in 
amounts with amount rates).

9. Variable Pay Computed Components: select Components and enter sequential 
order of display. Directions in Step 8 above apply here. 

10. Variable Pay Non Quota Components: select Components and enter sequential 
order of display. Also enter the earnings figure at 100% achievement of target 
level.

11. Map to Compensation Plan: entering the name of the Compensation Plan here 
will enable it to appear in Production when the activation process has been run.

Guidelines
Entering the Quota range enables the Quota Range Report to be run. The minimum 
quota on the Sales Role Details screen will be picked up on the Minimum Quota 
field on the Quota Modeling screen when the minimum function is invoked by the 
user. 

Compensation Plan Levels are used in the Quota Model Summary and Average 
Quota Summary Reports where the Quota for each Component are totaled, for each 
level of Salespeople in the Salespeople Hierarchy for the selected parameters 
(example, Organization, Effective Date) of each Report. 

Edit Computed Component Formula
Use this screen to define a formula for a Computed Formula.

Prerequisites
Components must be created.

Steps
1. Select a Component from the list of values.

2. Enter the percentage against this selected Component. Repeat steps 1 and 2 
until all variables of the formula have been defined.

3. Click Restore to retrieve the last saved set of information.

4. Click Save to save new information.
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Setting Up Planning Module
Guidelines
The percentages entered against each Component selected will be multiplied with 
the value of each Component. The results of all multiplication will be added 
together.

Define Quota Anchors
Use this screen to define a formula for a Computed Formula.

Prerequisites
Rate Tables and Components must be created.

Steps
1. In the Rate Schedule Detail section, enter the commission rate range for each 

tier of the Rate Table.

2. In the Quota Anchors Detail section, select Amount if entering the commission 
earnings amount for each attainment/achievement level. For Percentages, select 
percentage and enter the percentage for each attainment level. See Guidelines 
for more explanation.

3. Click Restore to retrieve the last saved set of information.

4. Click Save to save new information.

Guidelines
If the first tier of the Rate Table is 0 to 25%, enter 0 commission earnings against 0% 
attainment and then enter the commission earnings at the 25% attainment at the 
next line.

If the maximum attainment level is, for example, 200% of Quota and the maximum 
commission earnings are 2% of the transaction value, then, enter:
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Setting Up Planning Module
Default Contract Text
Use this screen to define the text that accompanies the Compensation Plan.

Prerequisites
Super User responsibility is required.

Steps
1. Enter the title of the Contract at the Contract Title field.

2. Enter the Eligibility Rules in the Club Qualification text box.

3. Enter the Terms & Conditions of the Compensation Plan. 

4. Enter the Approver’s details in the Approver section.

5. Click Restore to retrieve the last saved set of information.

6. Click Save to save new information.

Guidelines
The text in the Terms & Conditions text box can be made to refer to the location of 
the Terms & Conditions. Example, “I accept the Terms & Conditions as set out in the 
Company Handbook that is posted on the Notice Board or the Company Handbook 
that was issued with the Employment Contract.” This text will appear at the bottom 
of the Compensation Plan that will be generated later.

The Approver’s details will appear at the bottom of the Compensation Plan as well.

0 Percentage 0.00

25 Percentage 1.00

50 Percentage 1.10

100 Percentage 1.50

200 Percentage 2.00

9999 Percentage 0.00
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Job Title Summary
Use this screen to find a Job Title. After that, use the next screen, Job Title Details, to 
assign Sales Role(s) to the selected Job Title.

Prerequisites
Super User responsibility is required. Resources have been set up in Oracle 
Resource Manager.

Steps
Select a Job Title by clicking its name.

Guidelines
If using Oracle Human Resources Management System, the Job Title information 
here is read from HRMS via Oracle Resource Manager. If not using HRMS, please 
refer to Oracle Resource Manager for more information.

Job Title Details
Use this screen to assign Sales Role(s) to the selected Job Title.

Prerequisites
Super User responsibility is required. Resources have been set up in Oracle 
Resource Manager.

Steps
1. Under the Role column, click the list of values box to the right of the Role field.

2. Enter a search criteria for the Role name in the pop-up box.

3. Select a Role from search results.

4. Select a Start and End Date for the term of the assignment by using the calendar 
pop-up box or alternatively, input the dates in the dd-mmm-yyyy format.

5. Tick the check box to indicate which Role will be the default Role assigned to 
this Job Title.

6. Click Restore to retrieve the last saved set of information.

7. Click Save to save new information.
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User Summary
Use this screen to find a User. After that, the User Access Detail screen will allow 
alterations to the selected User’s access privileges.

Prerequisites
Super User responsibility is required.

Steps
Select a User by clicking on his/her name.

User Access Details
Use this screen to alter the selected User’s access privilege.

Prerequisites
Super User responsibility is required.

Steps
1. Selected User may have Update or View-only access to selected Compensation 

Groups and Organizations.

2. Click Restore to retrieve the last saved set of information.

3. Click Save to save new information.

Setting Up Production Module

Screen List for Production Module

Access from Topic

Menu bar: System System Parameters

Find System Profile Values

System Profile Values

Security Profile

Find Personal Profile Names
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Personal Profile Values

Oracle Sales Compensation Lookups

Descriptive Flexfield Segments

Segments Summary (new)

Segments (new)

Menu bar: Financial Set of Books

Closing

Journaling

Average Balances

Budgetary Control

Menu bar: Financial Multiple Reporting Currencies

Accounting Calendar

Period Types

Open and Close Periods

Currencies

Period Rates

Financial Setups Interval Type

Accumulation Period

Pay Periods

Credit Types

Credit Type Conversion Factors

Menu bar:   System Tables

Columns

Dimensions

Classification

Primary Key

Collection

Source Tables

Access from Topic
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Queries 

Mapping

Actions

Reporting

Revenue Classes Revenue Class

Hierarchies Hierarchies

Details

Import (sub hierarchy)

Hierarchies: Dimension name

Classification Rules Ruleset

Rules

Rule Attribute

Build Expression

Compensation Plans Rate Table

Rate Dim en ion

Assignment

Formulas

General

Input

Rate Table

Output

Plan Element

General

Revenue Class

Formula

Rate Tables

Compensation Plans

Plan Elements

Access from Topic
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Salesperson Assigns

Sales Roles

Menu bar:    Tasks Roles

Find Resources

Selection Criterion

Resource Search Results

Resource Details

Create Resource

Resource

Default Values

Roles

Groups

Teams

Service

Interaction Center

Compensation

Receivables

Miscellaneous

Define Groups

Members

Roles

Usages

Relations

Member Details

Move Member

Member Roles

Define Teams

Members

Access from Topic
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Roles

Usages

Member Details

MemberRoles

Define Sales Roles

Pay Groups Pay Groups

Pay Periods

Salespeople

Payment Plan

Salespeople Workbench

Salesperson (definition)

Sales Role

Compensation Plans

Payment Plans

Collection Submit Request

Run Calculation Calculation

Maintain 
Transactions

Maintain Transactions

Basic

Advanced

Adjust or New Transaction

Move Credit

Share Credit

Deal Move

Deal Split

Commission Lines Screen

Transaction History

Customer Address

Access from Topic
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Setting System Profile Options
The table below lists the profile options which need to be set to implement Oracle 
Sales Compensation after the product has been installed, but before the system is 
ready to be used to build compensation plans, collect and process transactions, and 
pay sales compensation. The options can be set in any sequence.

User Notes

Pay Pay Worksheet

Query Compensation Summary

Compensation Detail

Performance Summary

Sales Credit

Reports

Payrun Create Payrun

Payrun Details

Payment Transactions

Payment Plans for this Salesperson 

Payrun list by Period

Option Description

1. OSC: Collect on 
Account Credits

Default: Yes

Enables or disables collection of "on account credits". If set 
to Yes, then the application will collect invoices, regular 
credit memos, and account credit memos when collecting 
invoices. If set to No, then the application will collect only 
invoices and regular credit memos.

2. OSC: Commission 
Rate Precision

Default: Null

Determines the number of digits that will automatically 
follow the decimal point for the commission rate.

3. OSC: Debug Mode

Default: No

Locates errors generated by concurrent processes, such as 
calculation, collection, transaction interface loader, and 
upload and download hierarchy. Setting Debug Mode to 
Yes writes these errors to an internal audit table.

Access from Topic
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4. OSC: Default Custom 
Flag

Default: Yes

When set to Yes, the compensation plans are customized. 
Otherwise, they are not customized.

5. OSC: Log File

Default: No

If set to Yes, debugging messages are written to a log file. 
Only enable this profile option for debugging purposes if 
there are suspected problems with the application. If 
enabled, this profile option generates log files, which can 
affect performance.

6. OSC: Log File 
Directory

Sets the directory where the log file is stored. When you 
enter the directory path, you do not need to enter a slash 
after the name.

7. OSC: Mark Events Answer No while setting up your system. Change to Yes 
when you are ready to start collecting transactions. Every 
event such as a transaction is put into the Notify Log so 
that it will be included in the next calculation.

8. OSC: Prior 
Adjustment

Allows a period’s transactions to be calculated 
incrementally. If set to No, allows all plan elements in a 
period to be calculated incrementally. Before enabling this 
profile option, make sure that any transactions that have a 
processed date earlier than the latest processed date shown 
in the System Parameter window have been calculated.

9. OSC: Report Security 
Level

Assigns security levels to view and print reports within the 
company. Super User: View and print reports for all 
members of an organization. Analyst: View and print 
reports for anyone that is assigned to them. Manager: View 
and print reports only for the sales representatives that are 
below them in the hierarchy. Sales Rep @ Site: View and 
print only their reports.

10. OSC: Sleep Time in 
Seconds

Sets the amount of wait time in between each phase of 
calculation. The wait time gives each phase time to 
complete the current process without being queried by the 
system for a status. The default setting is 180 seconds (3 
minutes). For large volume transactions, use the default 
setting.

11. OSC: User’s 
Employee Number

Assigns a unique employee identification number to each 
user within the application who are managers and sale 
representatives. The system administrator generally assigns 
this number to all employees. The OSC: Report Security 
Level profile option uses this number to determine each 
user’s report viewing and printing access options.

12. OSC: User’s Type Select either Employee or Other for each user.

Option Description
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Implementation Steps
The table below summarizes the steps necessary to successfully implement Oracle 
Sales Compensation. Further information detailing the implementation procedures 
is provided in the sections following the table.

Step Action Description

1. Select a set of books Use System > System Parameters to select a set of books 
set up in General Ledger

1. Set up open/close 
periods

Use Financial >Open and Close Periods 

2. Copy periods from 
Oracle General 
Ledger to Oracle 
Sales Compensation

Use Financial > Pay Periods and select Active for each 
period in the general ledger you want to copy and use in 
Oracle Sales Compensation.

3. Activate periods Use Financial > Accumulation Periods to assign Future 
Enterable for setting up plans and salespeople, or Active to 
process transactions.

4. Financial > Define 
Interval Types

Define quota intervals by assigning a name, selecting a 
calendar, and assigning an interval number to each period. 
Or, optionally, use the predefined intervals provided 
(Period, Quarter, Year). 

5. Define 
responsibilities

Optional. Default responsibilities are provided. Use 
Security > Responsibility Define to create custom 
responsibilities.

6. Assign user 
responsibilities

Use Security > Responsibility > Define to set up user 
responsibilities. 

7. Define credit types Optional. Use Financial > Credit Types to define additional 
non-monetary credit types.

8. Set credit type 
conversion factors

Optional. Use Financial > Credit Type Conversions to set 
conversion factors for converting one credit type to another, 
such as to convert non-monetary credit types to your 
functional currency.

9. Set collection 
parameters, 
salesperson batch 
size, and select 
Managerial Rollup

Use System > System Parameters to set the number of 
transactions to collect per batch, the number of transactions 
to transfer from the Collector to the Calculator, and the 
number of days to allow after payment due date before 
sales credit is taken back. Set the number of salesperson 
periods in a sales compensation calculation batch. 
Optionally, select Managerial Rollup to enable the rollup of 
credits through the compensation group hierarchies.
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Defining the Calendar
To use Oracle Sales Compensation you must define the calendar and set of books on 
which you want to base your compensation periods. If you have already defined 
these in Oracle General Ledger, you need to identify this information in Oracle Sales 
Compensation. 

Define the set of books in Oracle General Ledger (GL) using these forms:
Set of Books 

Calendar 

Period Types 

Open and Close Periods 

Key Flexfields

Select the set of books in Oracle Sales Compensation
A set of books identifies a company or fund within Oracle Applications that shares 
a common chart of accounts, structure, calendar, and functional currency. Oracle 
Sales Compensation processes sales compensation payments according to periods 

10. Map tables for data 
collection

See Mapping.

11. Set rule batch size 
parameter in System 
> System Parameters

The Rule Batch Size parameter is used by the code 
generation program to determine how many PL/SQL 
packages should be created for a revenue classification. 
This parameter needs to be set because the PL/SQL 
compiler limits the size of the PL/SQL blocks and gives a 
"program too large" compilation error when this limit is 
exceeded.

12. Create manual 
transaction reason 
codes

Optional. If you want reason codes identified for manual 
transactions, then set them up in the ADJUSTMENT_
REASON lookup table. Use System > Lookups. See the 
Oracle Application Object Library Reference Manual.

13. System > Security 
Profile

Optional. If you want to grant a manager security access to 
compensation information for salespeople not included in 
normal security for the manager, then set up the 
relationship using this window.

Step Action Description
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defined in a calendar associated with a set of books you define in Oracle General 
Ledger (see Oracle General Ledger Reference). 

Prerequisites
None

Steps
1. Navigate to the system Parameters window, or by default choose System 

Parameters from the Setup menu.

2. Enter a name for your Oracle Sales Compensation instance.

3. In the Set of Books field, choose a GL set of books from the list of values, which 
Oracle Sales Compensation obtains from all sets of books you have defined.

You will then see displayed this information obtained from the GL books:

� Calendar associated with this set of GL books (view only, cannot be edited)

� Period Type associated with this set of GL books (view only)

� Currency associated with this set of books

4. Define the Collector Set of Books. You must be in the collector instance, and 
from the System parameters window pick the same set of books as you are 
using in your Oracle Receivables source. 

Open and close periods in Oracle Sales Compensation
To administer Sales Compensation periods, set up your periods to the Future 
Enterable state. When you are ready to calculate the sales compensation payments, 
open the appropriate accounting period. You may close an accounting period after 
you have calculated and paid the compensation, or you may leave multiple periods 
open if you expect to make adjustments for prior periods.

Oracle Sales Compensation uses period information for these functions:

� Compensation plans and plan elements

� Compensation plan assignments

� Period targets and period draws

� Hierarchies

� Salesperson rollup structure

� Adjustments to sales credits
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� Account adjustments to subledger account balances

� Employment start and end dates

Steps
1. To change period status, navigate to the Periods window, or by default, choose 

Periods from the Administration menu.

Oracle Sales Compensation displays the following period information:

� For System Status: INACTIVE (never opened) or ACTIVE (permanent 
status after a period has been opened)

� Name, Year, Quarter, Start Date, End Date 

� Default value for Period Status is Never Opened, but it can change to:

Open, Closed, Permanently Closed, Future-Entry

� Status Code for salespeople for the period: unclassified (no activity or not 
yet recalculated after changes), classified (one or more salespeople failed 
the population process), populated, calculated.

Note: Changing a revenue class, salespeople, or classification rules 
hierarchy or a compensation plan automatically changes the period Status 
Code to Unclassified and you must recalculate the period.

2. Select the period and then choose a period status: Future Enterable, Open, Close 
Permanently, Close

When changing the period status you can change a Never Opened period to 
Future Enterable and then to Open. You can close an Open period and open a 
Closed period.

You cannot change a Permanently Closed period.

Note: once you permanently close a period, you cannot reopen it and no 
transactions of any kind can be processed. Be sure that there are no new 
transactions, adjustments, clawbacks, payments, or any other outstanding 
transactions before you permanently close a period.

Collecting Transaction data 
To collect transaction data, specify: 

1. The transfer batch size in the System Parameters window. A typical batch size is 
2000 transactions, but that depends on your system.
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2. The calculator instance, if you are using separate collector and calculator 
instances. Use the Calculator Database parameter in the System Parameters 
window.

Setting Up Collections
Two major processes are required to compute sales compensation: data collection 
and compensation calculation. 

As a data collector, Oracle Sales Compensation provides the means to collect data 
from Oracle Receivables, Oracle Order Capture, or other data sources and to 
prepare that data to be transferred to the Oracle Sales Compensation calculation 
processes. 

When the Oracle Sales Compensation calculation process receives transaction data, 
the data is classified according to rules created to match an organization’s business 
model. Rules may be defined to classify transactions by product, geography, type of 
customer, and so on. When a transaction is classified, Oracle Sales Compensation 
determines whether a person should be compensated for that type of transaction. 
The plan elements that are the components of a compensation plan are then used to 
apply the appropriate formula to transactions to calculate compensation. Finally, 
Oracle Sales Compensation provides the information needed to update the 
compensation information for each salesperson.

Setting Up A New Transaction Source
The screen shot below shows the Collections form, which is divided into two main 
areas. Existing Transactions Sources are listed at the top of the form. For each 
Transaction Source there are three pieces of information:

� Name: user-defined and changeable, and may include legacy sources.

� Type: the short-name of the Transaction Source. User-defined, must be unique 
and cannot be changed.

� Status: Complete/Incomplete. This indicates whether the Collection package 
has been generated for the Transaction Source since the latest setup changes 
were made.
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The currently selected Transaction Source is Legacy, which has been set up to 
illustrate the example Transaction Source described earlier in this guide.

Beneath this list is a tab metaphor, an area that looks like a set of five tab dividers. It 
contains detailed setup information for the currently selected transaction source: 
Source Tables, Queries, Mapping, Actions, Reporting. Use these tabs as described 
here. 

Source Tables
This tab is used to specify all tables that are used during the creation of 
compensation transactions, that is, the Direct Mapping tables. Supply the required 
information in each field.

� A Line table is mandatory. It contains the line items against which 
compensation is to be paid. L_ORDER_LINES has been designated as the Line 
table. 
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� The Key Column is mandatory: it is the field in the table that uniquely identifies 
each line. 

� Specify any additional tables to be used in creating compensation transactions 
in the Extra Direct Tables List.

� Optional Header Table area, in which the L_ORDER_HEADERS table has been 
specified. (The reason for this will be explained under the Queries tab.) If you 
specify a Header Table, also specify a Key Column for it and in the Line Table 
Header Identifier specify the field in the line record (foreign key) which allows 
it to be joined to the Key Column of the Header Table.

Tables and Columns form: Before you can use any table, register that table using 
the separate Tables and Columns form (below). Note that the table aliases are 
system-defined. These are the values that you must use if you refer to a table by its 
alias.

The Tables and Columns form requires the table name, user name, alias (which is 
automatically generated), and description, and whether it is to be used in a 
calculation.

For the Columns tab you must supply user column name, indicate data and type 
length. 
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Queries
Within this tab the significance of the information entered in the Source Tables tab 
becomes apparent. The capability for querying depends on the information entered 
into the Source Tables. You can generate a list of transactions that are eligible for 
compensation using the Notification Query and Parameters.
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Notification Query 
Look at the Notification Query and Parameters section. This shows the exact query 
that is used to create the Notification list of line-level transactions which are eligible 
for compensation. The FROM clause and the initial part of the WHERE clause are 
automatically filled according to the information entered on Source Tables tab. The 
query joins together the mandatory Line table (L_ORDER_LINES) and the optional 
Header table (L_ORDER_HEADERS). It is necessary to specify a header table, even 
though the purpose of Notification is to get a list of identifiers from the Line table. 
The reason for this lies in the additional criterion which has been added to the end 
of the WHERE clause:

AND loh10000.booked_date BETWEEN p_start_date AND p_end_date

This restriction means that the user wants to collect only the orders that were 
booked between a specific start and end dates. The booked date of the order resides 
in the Order Header, so it is necessary to bring the L_ORDER_HEADERS table into 
the Notification Query to allow this. This requirement often applies, so the Header 
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Table field on the Source Tables is provided to enable this match without the need 
for advanced SQL knowledge.

P_start_date and p_end_date are parameters whose values are set by the user before 
collections is run for this Transaction Source. Although the parameters must be 
registered on this tab, their runtime values are set on a different form (Setup -> 
Collection Parameters menu option). A separate form is used because for any changes 
made on the Collections form to take effect, it is necessary to regenerate the 
collections package, whereas the parameter values can be changed without needing 
to regenerate.

Collection Query
The list of tables in the Collection query FROM clause (the Direct Mapping Tables) 
consists of the Line table, the (optional) Header table and all of the tables listed as 
Extra Direct Tables on the Source tables tab.

The WHERE clause of the query already contains the necessary join information to 
get the right rows from the Line and Header tables. The user is required to complete 
the WHERE clause with all the join information necessary to get the right rows from 
the Extra Direct tables.

Once the information on the Queries tab is entered, you have completed all the 
setup necessary to build a correct set of compensation transactions from the source 
tables in your legacy system. The next step is to define what information will 
actually be stored in the compensation transaction. That is the function of the 
Mapping tab.

Mapping
Use the Mapping tab to specify what data is needed to fill each destination column 
when a compensation record is collected from the Transaction Source. The mapping 
tab is shown in the screen shot below.
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When you move to the Mapping tab for the first time after creating a new 
Transaction Source, you will see that the Source/Destination list on this tab has 
been pre-populated with a number of records. These records are the mappings for 
the mandatory Destination Columns, those columns in CN_COMM_LINES_API 
that must always be filled before a CN_COMM_LINES_API record can be imported 
into Oracle Sales Compensation. Examples of mandatory columns are Employee_
Number, Transaction_Amount, Transaction_Type and Source_Doc_Type. You 
cannot delete these mandatory mappings.

In some cases the Source Field for the mapping, that is, the description of the data 
used to fill the Destination Column, has been pre-populated and cannot be updated. 
An example of this is the mapping for Source_Doc_Type, which is set to be the Type 
that you enter when you name the Transaction Source (‘LEG’ in our example). Most 
Source fields are left blank though and you have to define the source data for these 
mappings. You can not generate a Collection package if any mapping has a blank 
Source (although you can enter the value NULL in the Source field if you need to).
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The Source field can contain a simple column specification or any other valid SQL 
expression. Each of the following is potentially a valid Source value:

Direct and Indirect Mappings are set up differently. A description of each follows.

Direct Mappings
 These are very simple to set up. Direct Mappings are those where the source data is 
derived exclusively from one or more tables in the FROM clause of the Collection 
Query (any table listed on the Source Tables tab). 

If the Source data does not include any database information at all--if it is just 
NULL or a literal value --then this can also be regarded as a Direct Mapping.

To define a Direct Mapping, type the appropriate SQL expression into the Source 
field. A Direct Mapping is simply incorporated into the Collection Creation query 
that was described earlier. This single SQL statement already knows how to join all 
of the Direct Mapping tables together, so you need to define only what column 
information (if any) you need from these tables.

Notice that all seven of the example expressions above refer either to no table data 
at all, or only to columns from one of our Direct Mapping tables. These are therefore 
valid Direct mappings in the context of our example setup. Suppose for example 
that for the Quantity Destination Column, you want to use NVL(lol10001.ordered_
quantity, 0) as the Source value. All you would need to do is type exactly this text 
into the Source field for that mapping.

Although you can type this text directly into the Source field, this approach is 
potentially error-prone. You need to spell the column name (ordered_quantity) 
correctly and you should normally precede that with either the full name of the 

NULL   NULL value

’My Text’   literal value

booked_date   column_name

l_order_headers.booked_date   table_name.column_name

loh10000.booked_date   table_alias.column_name

NVL(lol10001.ordered_quantity, 0)   SQL function

my_function(loh10000.booked_
date,lsc10002.salesrep_id)

  user function
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source table (l_order_lines) or the exact alias of the table (lol10001). Instead of this 
manual procedure, you can press the Source Builder button to get a List Of Values 
(LOV) to help you. This is presented in a dialog box as shown below.

       

 The required Source field text, for example, can be created as follows:

1. Type NVL( in the Expression field.

2. Click the Table Name LOV. The names of the Direct Tables are listed.

3. Select L_ORDER_LINES.

4. Click the Table Name LOV. The names of the L_ORDER_LINES columns are 
listed.

5. Select ORDERED_QUANTITY

6. The text lsc.amount is appended to the expression field

7. Type , 0) at the end of the Expression field
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8. Click Apply. The dialog disappears and the full expression is now pasted into 
the Source field.

Alternatively, you can use Source Builder to paste the lol10001.ordered_quantity 
text into the Source field and then build the rest of the expression up in the Source 
field itself.

Indirect Mappings 
Indirect Mappings are more complex. They are implemented as UPDATES to the 
existing CN_COMM_LINES_API record you need to define the FROM and WHERE 
clauses of this UPDATE statement. There are two ways that this definition is 
performed, the Free-Form Indirect Mapping and the Relationship Indirect Mapping.

With a Free-Form mapping you must type in the exact FROM/WHERE clause 
manually on the Mapping tab. With a Relationship Mapping you first use the 
External Tables form to define a join relationship between CN_COMM_LINES_API 
and the table from which the source data is to be collected. Then on the Mapping 
tab you specify this join relationship in the Relationship field. The FROM/WHERE 
field then becomes read-only and is automatically set according to that Relationship 
definition.

In the example in the Concepts section, we wanted to store the salesperson territory 
in the Attribute1 field of CN_COMM_LINES_API. The territory can be taken from 
L_TERRITORIES, using the Salesrep_ID, which is also present in the L_SALES_
CREDITS table.

The first requirement to implement this is to set up a Direct Mapping which stores 
the Salesrep_Id from L_SALES_CREDITS. Set up the Direct Mapping as follows:

1. Create a new record in the mappings list.

2. Enter lsc.salesrep_id in the Source Field.

3. In the Destination field select a spare column, like Attribute99, from the LOV 
DO NOT use the Salesrep_ID destination column: the reason why is explained 
later in Mapping the Employee Number.

A Free-Form Indirect Mapping for Territory can be set up as follows:

1. Create a new record in the mappings list.

2. Enter FROM l_territories lte WHERE lte.salesrep_id = api.attribute99 in the 
FROM/WHERE field.

3. Enter lte.territory_name in the Source field. Note that if you use Source Builder 
to do this, the Table Name LOV will list all of the tables that are currently 
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registered (in Tables & Columns) in Oracle Sales Compensation. This is because 
the FROM clause is free-form text which could contain multiple tables. It is 
easier to list all the tables for the user to choose from than to try to extract table 
names out of the FROM/WHERE clause.

4. In the Destination field select Attribute1 from the LOV.

Alternatively, a Relationship Indirect Mapping for Territory can be set up as 
follows:

1. Use the External Tables form to set up a join relationship. In this relationship the 
Source Table is L_TERRITORIES and the Destination Table is CN_COMM_
LINES_API. The Source Column is Salesrep_id and the Destination Column is 
Attribute99.

2. Go back to the Mappings table of the Collections form. Create a new record in 
the mappings list.

3. Use the LOV on the Relationship field to select the relationship that you have 
just set up. The FROM/WHERE clause is now automatically populated.

4. Enter lte.territory_name in the Source field. Note that if you use Source Builder 
to do this, the Table Name LOV will list only L_TERRITORIES because this is 
the source table for your chosen relationship.

5. In the Destination field select Attribute1 from the LOV.

Whether you set this up as a Free-Form or a Relationship mapping, you will see that 
the following text is displayed beneath the Relationship field:

UPDATE cn_comm_lines_api api SET attribute1 = SELECT lte.territory_name

The FROM/WHERE field completes the statement:

FROM l_territories lte WHERE lte.salesrep_id = api.attribute99

This shows you in SQL terms exactly how your Indirect Mapping will be physically 
implemented. If you look back to the screen shot at the start of the Mapping section, 
you will see that it shows the use of a Free-Form Indirect Mapping to populate 
Attribute1.

Indirect Mappings: Free-Form or Relationship. When should you use a Free-From 
Indirect mapping and when should you used a Relationship mapping?

The Relationship Mapping is more restrictive than the Free-Form version. On the 
External Tables form you can only define simple equivalence joins between tables, 
which means joins of the form:

WHERE table1.columnA = table2.columnB
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      AND table1.columnC = table2.columnD

This rules out the use of other tests such as OR, BETWEEN, <, != and so on as well 
as the use of functions such as NVL and the outer join operator.

A relationship also only allows you to join to a single Indirect table. If you need to 
join multiple tables together then you cannot use the Relationship option, unless 
you create a custom view to hide the join.

In the cases described above, the Free-Form mapping is therefore the one to choose.

There is no occasion where you actually have to choose a Relationship mapping 
over a Free-Form one. Relationship mappings would be chosen because of setup 
simplicity (they can be re-used in multiple mappings) and maintainability. 

Mapping the Employee Number. The salespeople used by Oracle Sales 
Compensation are set up using Oracle Resource Manager. When you define 
resources in Oracle Sales Compensation, you are actually using Resource Manager 
screens. The Sales Credits which are managed and calculated within Oracle Sales 
Compensation are linked to their owning salesperson using the Salesrep_ID 
allocated for the salesperson by Resource Manager.

The problem which arises when importing transactions from a legacy system is that 
the Salesperson Identifier on a legacy record will not match the Salesrep_ID for that 
person which was allocated when he/she was registered in Oracle Sales 
Compensation. The Resource Manager Salesrep_ID is an internal key which is not 
visible to the user and is also non-updateable.

A way is therefore provided to make this link between ‘Legacy’ salespeople and 
Oracle Sales Compensation salespeople. The solution is as follows:

When creating a new Resource in Oracle Sales Compensation, one of the fields to be 
filled in is ‘Resource Number’. In this field you should record the user-visible 
unique identifier that this person has in your legacy system.

On the Mappings tab set the Source of the mandatory ‘Employee_Number’ 
mapping to be person identifier column from your legacy system.

When records are subsequently imported from CN_COMM_LINES_API into Oracle 
Sales Compensation, if the CN_COMM_LINES_API.Salesrep_ID column is 
blank, the load program will take the value in CN_COMM_LINES_API.Employee_
Number, find the individual in Resource Manager whose Resource Number is equal 
to that value and then populate CN_COMM_LINES_API.Salesrep_ID with the 
Resource Manager Salesrep_ID for that individual.
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Actions
The Actions tab allows the user to change the Collection processing for their 
Transaction Source in two ways, either by specifying the Transaction Filters or by 
adding User Code Blocks. Transaction Filters are more relevant in conjunction with 
the pre-defined Transaction Sources of Receivables and Order Management, so they 
will be discussed later.

User Code Blocks are single or multiple PL/SQL statements which you can choose 
to have inserted at defined points within the Collect procedure that will be 
generated for your Transaction Source. You can insert User Code Block at three 
locations:

Pre-Notification: the beginning of the procedure

Post-Notification: between running the Notification and Collection queries

Post-Collection:   after the Collection query has been run

To create a User Code Block, choose the required Location from the selection list 
and then type your statement(s) in the Code field.
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Reporting
 When the preceding setup is complete, you are nearly ready to press the Generate 
button and create your Collections package. However, since pressing that button 
will replace the existing version of the package with a new one based upon the 
current setup, test first whether this new package is valid. The Reporting tab 
enables you to test the validity of the new package.

When the Test Generate button on this tab is pressed, a test version of the Collection 
package is generated for the selected Transaction Source.
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The Error Text field lists compilation errors in the generated package together with 
their line numbers. The Package Text field displays the entire code, with line 
numbers, for the package. This way, if any errors are listed for the package, you can 
easily find the offending line of code in the Package Text field.

The usual cause of a compilation error is invalid SQL which has been typed in on 
the Queries or Mappings tabs or, as in the screen above, in a User code Block. It is 
easy to identify such problems on the Reporting tab, go back and fix them and then 
re-run the test generate.

Hint: when you look at the Package Text, click the field and then click the Edit Field 
icon in the toolbar. This brings up the contents of the field in a resizeable window so 
that you can see more lines and greater line width.

Apart from finding compilation errors, the other main use of this tab is to allow you 
to scan through the generated package and confirm that it is doing what you had 
intended when you set up the information on the other tabs. It enables you, for 
example, to see exactly where in the Collect procedure your User Code Block(s) will 
be executed.
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Running Collections
When you are satisfied with the results of a test generation, press the Generate 
button to create the real Collection package for your Transaction Source. 

It is recommended that you actually run the package to collect transactions. This is 
accomplished by the Collect Custom Transaction Source Concurrent program. This 
program requires you to enter a single parameter, the name of your Transaction 
Source. The LOV on this parameter lists all custom Transaction Sources that have 
been set up.

Remember that if you created any parameters on your Queries tab, you do not set 
their values on the Concurrent Program run form. You have to use the Collection 
Parameters form to set their runtime values before you call up the Concurrent 
Program.

The final action required to pull these transactions from the API table into Oracle 
Sales Compensation is to run the Transaction Interface Loader concurrent program, 
or to press the Load Transactions button on the Maintain Transactions form.

Setting Up A Standard Transaction Source
Oracle Sales Compensation is delivered with two pre-defined Transaction Sources: 
Oracle Receivables and Oracle Order Capture.

The setup of Collections for these Transaction Sources is very similar to the setup of 
new user-defined Sources. The major difference is that for the Standard Transaction 
Sources you cannot make any changes to the Source Tables or Queries tabs. In fact 
you cannot even select the Queries tab to view its contents. This is because 
collection from Receivables and Order Capture is implemented as complex 
procedural logic rather than as simple Notification and Collection queries and it is 
not possible to express that logic on the Queries tab.

Both the Standard Transaction Sources are delivered with a set of mappings to 
populate the important columns in CN_COMM_LINES_API. You are allowed to 
change Source values for these mappings and also to create new mappings of your 
own. The Mappings tab for Receivables is shown below. 
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Note the Inherited column on the right side of the tab. When you first display the 
Mappings tab for a Standard Transaction Source, this column will display === for 
every mapping. This tells you that the mapping is a standard one and has not been 
changed. If you change the value in either the Source, Relationship or 
FROM/WHERE field for a standard mapping, the Inherited column will change to 
display =X=. If you want to revert a mapping to its original standard setup, press 
the Inherit button. The Source, Relationship and FROM/WHERE fields change back 
to their original values and the Inherit field reverts to ===.

If you create any new mappings, the Inherited column is blank for these rows and 
the Inherit button has no effect.

Using Filters
Since you cannot access the Queries tab for a Standard Transaction Source, you 
cannot change the collection query to filter transactions that you do not want. This 
is why the Filters on the Actions tab are useful for these Transaction Sources.
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Filters allow you to define criteria for the removal of unwanted transactions. 
Suppose for example you do not want to compensate people for any transaction 
with a value of less that $100 (we will assume that all your sales are in dollars). You 
can specify this on the Actions tab simply by entering the text api.transaction_amount 
< 100 on a line in the Filters section of this tab. 

Alternatively you can press the Clause Builder button to help you build this 
expression. Clause builder works in the same way as the previously described 
Source Builder, except that you do not choose a table, since the filter always applies 
to a column in CN_COMM_LINES_API.

You can also decide which method of filtering should be carried out for your 
Transaction Source, using the radio button in the Filter section. If you select Physical 
Delete then filtered transactions are physically deleted from CN_COMM_LINES_
API. If you select Mark As Filtered, the transactions are not deleted - they are 
marked as FILTERED and are never imported into Oracle Sales Compensation.
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Receivables and Order Capture Special Features

Oracle Receivables
The pre-defined Receivables data source differs slightly from any other data source 
because it really represents four Transaction Sources which have been combined 
into one, so that they can share a set of Mappings. The four sources are referred to 
as Receivables Events and are as follows:

� Invoices, Credit Memos and Debit Memos

� Take-backs (once an invoice due date goes beyond the set grace period, the 
credit for the sale is deducted from the salesperson’s sales credit)

� Payments and Givebacks (a Giveback is a past due invoice that had been Taken 
Back but has now been paid)

� Write-offs

These events occur when the relevant transaction is posted to the Oracle General 
Ledger application.

The Transaction Collection Queries for these Events are all based around the same 
core set of Receivables source tables, but the tables are joined together in different 
ways so four different Transaction Sources would normally be required. The four 
have been combined into a single Transaction Source so that you set up only the 
Mappings that you want once and they are applied to the collection of 
Compensation Transactions for all four Events. 

When you press the Generate button for the Receivables Transaction Source, four 
packages will be generated, one for each Receivables Event. This generation takes 
four times as long as for any other Transaction Source. However, you may not be 
interested in all these Events. It is therefore possible to restrict the generation to 
only those packages for the Events that you require. When the Receivables 
Transaction Source is selected, a special table appears on the top-right corner of the 
screen (see below).
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Use this table to select Events. In the screen shot above, the user has selected only 
the Invoice (plus Credit/Debit memo) Event. When the Generate button is pressed 
the full package will be generated for the collection of Invoices, Credit Memos, and 
Debit Memos. For the other three Events (Write-offs, for example) simple stub 
packages will be generated. This speeds up the Generation process.

Each Receivables Event has a dedicated Concurrent Program. Each of these requires 
two parameters - a Start Period and End Period. The parameter entry is supported 
by a List Of Values. The Concurrent Programs are as follows:

� Collect Invoices

� Collect Clawbacks

� Collect Payments And Givebacks

� Collect Writeoffs
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Oracle Order Capture
 Compared with Receivables, the Order Capture Transaction Source behaves more 
like the user-defined Transaction Sources which were defined earlier.

A single Collection package, Collect Orders, is called by a dedicated Concurrent 
Program. The Concurrent Program requires two parameters, a Start Period and End 
Period. The parameter entry is supported by a List Of Values.

Although this Transaction Source collects from Order Capture, the transactions 
actually originate in the Oracle Order Management product. Order Capture just acts 
as an interface. The transactions themselves are sales credits for Orders which have 
reached the Booked status in Order Management.

Adjustments
Order information can be, and often is, changed after the Order has been set to the 
status of Booked. Such changes, known as adjustments, can be automatically 
applied to transactions which have already been Collected. If a change is made to 
any Line on an Order then all of the Sales Credits (Compensation Transactions) for 
that line are considered to be changed. There are two possible scenarios:

� The Compensation Transactions have been Collected but have not been Loaded 
into Oracle Sales Compensation.

� The Compensation Transactions have been Collected and also Loaded into 
Oracle Sales Compensation.

In Scenario 1, the transactions have only got as far as the CN_COMM_LINES_API 
table. In such cases the original transactions are marked OBSOLETE and they will 
be re-collected into CN_COMM_LINES_API with their new values the next time 
Collect Orders is run.

In Scenario2, the transactions are already inside Oracle Sales Compensation and 
may have even been used to calculate salesperson commission. This requires a 
different approach. The original transactions in CN_COMM_LINES_API are 
marked FROZEN. For each of these a reversing transaction is also created in CN_
COMM_LINES_API. This is a duplicate of the FROZEN line, but with an opposite 
polarity (usually meaning it becomes negative) on the Transaction Amount. This 
transaction will have the effect of reversing out the original. Finally, as in scenario 1, 
the Compensation Transactions for this line will be re-collected into CN_COMM_
LINES_API with their new values the next time Collect Orders is run.

Each time Collect Orders is run, the list of unprocessed updated Order Lines must 
first be processed. This can take rather a long time. To avoid having a long wait 
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when running Collect Orders, it is a good idea to process this list of updated Order 
Lines at regular intervals (perhaps daily). There is a Concurrent Program to do this, 
Order Update Notification.

The list of updates to Orders is maintained for Oracle Sales Compensation by the 
Order Capture application. This however only occurs if Order Capture has been 
informed of this requirement. You must register Oracle Sales Compensation with 
Order Capture as follows:

1. Switch Responsibility to Oracle Order Capture

2. Open the Lookups form

3. Display the ASO_ORDER_FEEDBACK_CRM_APPS lookup type

4. If it is not already there, create a row with Code CN, Meaning Sales 
Compensation and check the Enabled box. Save this row.

Coping With Adjustments  You can cope with adjustments to transactions in your 
custom Transaction Sources in the same way as standard Collections from Order 
Capture does. All you need to do is to call a Collections API, identifying the 
transaction that has been changed.

If you specified a Header Table on your Source Tables tab then you need to pass the 
unique identifiers of both the Header record and the Line record of the changed 
transaction. Otherwise only the identifier of the Line record is required.

Suppose that Collections has already been run for October 2000 transactions in our 
example legacy system. We have also imported those transactions into Oracle Sales 
Compensation. Now a change is made to one of the orders for that month. The ID of 
the Order Header is 1001 and the ID of the Order Line is 1234. To notify Oracle Sales 
Compensation of this change you make the following call:

CN_NOTIFICATION_PUB.Create_Notification

   

 ( p_api_version         =>  1.0,

 x_return_status         =>  l_return_status,  -- OUT parameter

 x_msg_count             =>  l_msg_count,  -- OUT parameter

 x_msg_data                =>  l_msg_data,  -- OUT parameter

 p_line_id                     => 1234,  -- Line Table Id

 p_source_doc_type   =>  ’LEG’,  -- Transaction Source Type
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The next time Collections is run for this Transaction Source, reversing transactions 
will be created to nullify all sales credits associated with this transaction line. All 
sales credits will then be collected again with the new values in. This reversal and 
re-collection of the October transaction will occur even if you specify that you want 
to collect only November transactions this time.

Note: to understand the p_org_id parameter, you need to first understand the 
Oracle Applications ‘Multi-org’ strategy, which allows data for multiple operating 
units to exist, partitioned from each other, within a single database. Discussion of 
Multi-org is beyond the scope of this document. If you don’t understand this 
concept then please consult the appropriate documentation before trying to 
understand the rest of this paragraph. If your procedure which calls CN_
NOTIFICATION_PUB.Create_Notification is running in a database session where the 
Org-Id has been set, and your procedure is only dealing with transactions for this 
Org-Id, then you can omit the p_org_id parameter. In any other situation (for 
example where you have a single procedure or database trigger which detects 
updates to transactions from multiple Org-Ids) you must specify the correct value of 
p_org_id for the transaction when you call Create_Notification.

Setting up Classification

 Creating Revenue Classes and Hierarchies 
Revenue classes are user-defined categories of business revenue used to determine 
whether a sales credit is applied toward a compensation payment. A hierarchy 
composed of broader revenue classes at the top, or root, with subclasses as children 
of the root, make it possible to pay compensation for broader revenue classes 
without specifying all possible subclasses in a compensation plan. Use this 
procedure to define your revenue classes and build hierarchies of revenue classes.

 p_adjusted_flag        =>  ’Y’,  -- Adjustment(not new record)

 p_header_id             => 1001, -- Header Table Identifier

 p_org_id                     =>  your_org_id,  -- Operating Unit (optional)

 x_loading_status     =>  l_loading_status  -- OUT parameter

 );
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Categorizing Your Sales Revenue
You begin defining revenue classification by identifying your organization’s 
revenue classes and then defining these classes in Oracle Sales Compensation.

What Is a Revenue Class?
A revenue class is a user–defined category of sales for which your organization 
awards compensation. Each revenue class represents a different type of sale for 
which your organization pays compensation. Thus, different companies have 
different revenue classes because each sales organization awards compensation 
differently. After defining your organization’s revenue classes, you assign one or 
more revenue classes to a compensation plan and assign the plan to a salesperson. 
By assigning revenue classes, you specify the types of revenue for which each 
salesperson can earn compensation.

Many companies award compensation based on the types of products or services its 
salespeople sell. Depending on the business practices of your sales organization, 
you might award compensation based on factors other than products or services 
sold. For example:

� Your sales organization might have customer account teams, where salespeople 
only receive compensation for sales to their assigned set of accounts. In this 
case, each customer account is probably a separate Oracle Sales Compensation 
revenue class.

� Your company might organize its sales strategy around expansion into new 
markets, where each new market is defined as a separate revenue class.

� Your company might use industry–based sales compensation, paying 
compensation only for sales made in a salesperson’s assigned set of industries.

For a specific example, Global Computers awards compensation based on the types 
of products or services its salespeople sell. At the broadest level, the company sells 
PCs, peripherals, education services, consulting services, and support maintenance 
services. While some types of salespeople, such as resellers, are only authorized to 
sell a subset of this offering, the company awards compensation to some of its 
salespeople for all types of products and services. Thus, for Global Computers, each 
product or service category is an Oracle Sales Compensation revenue class.

Defining a Revenue Class
A revenue class is a user-defined category of sales for which your organization 
awards compensation. Many organizations award compensation based on the types 
Implementing Oracle Sales Compensation 53



Setting up Classification
of products and services they sell. In that case, the products and services are 
grouped into revenue classes and arranged into hierarchies with broader categories 
at the top, or root, of the hierarchy.

When matching the revenue class on a compensation transaction, such as a sales 
order, to a revenue class on a salesperson’s compensation plan, the class of the 
transaction is rolled up in the revenue class hierarchy to determine matches to any 
revenue class on the plan.

All revenue classes on the same plan element share the same quota and 
compensation rate table. If revenue classes in a compensation plan have different 
quotas or are paid according to different rate tables, you must create a plan element 
for each revenue class that has a different quota or compensation rate.

Use this screen to create Revenue Classes.

Prerequisites
Liability and Expense Accounts have been determined.

Steps
1. In the Navigator, choose Classification Rules > View By Revenue Classes.

2. In the hierarchy, right-click Revenue Classes and choose New.

The Revenue Class window appears.

3. Enter the names and descriptions for all revenue classes you have identified.

4. Select a Liability Account and Expense Account, if applicable.

5. Save your work by clicking File in the toolbar and Save in the drop down 
menu.

Hierarchy
Use this screen to assemble Revenue Classes into hierarchies.

Prerequisites
Revenue Classes have been created.

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.
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2. Enter a name for your hierarchy.

3. Enter the start and end dates for the hierarchy.

4. Save your hierarchy.

5. Click View Details.

The Hierarchies window displays the existing available root classes. The 
application provides a default root class called Base Node.

6. Enter one or more root class names.

When you select the root name, it appears in the large box. A plus sign next to 
the name in the box indicates you can click it to expand and view the hierarchy 
that is part of the selected root. You can expand and view any level of the 
hierarchy.

7. In the large box, select the parent revenue class for which you want to add a 
child.

8. Click Add.

The Hierarchy Elements window displays the existing children for the selected 
revenue class.

9. Use the list of values to add a revenue class.

10. Click OK.

The added revenue class appears in the hierarchy.

11. Repeat from step 11 to build your hierarchy.

12. Save your work periodically and again before you exit the window.

Guidelines
You can create as many hierarchies as you need. However, only one hierarchy can 
be effective at any given time.

You can import any portion of another hierarchy to become a child of your selected 
node in the hierarchy you are building.

Creating Classification Rules
A classification ruleset is used to classify sales transactions to determine the 
appropriate revenue class for the transaction. Using the revenue class, a transaction 
is matched with a compensation plan and a compensation amount to be paid for the 
Implementing Oracle Sales Compensation 55



Setting up Classification
transaction is calculated. Use this procedure to define a set of attributes and values 
that uniquely identify each revenue classification.

Guidelines
Name your rules after the revenue classes they describe. Rules do not require 
unique names.

Tables
Use this screen to define the descriptive flexfields in CN_COMMISSION_
HEADERS table.

Prerequisites
Super User responsibility is required.

Steps
1. From the Menu bar, choose Toolbar > System > Tables and Columns.

2. Place the cursor on the first line in the Schema column. Find the CN Schema 
and the CN_COMMISSION_HEADERS table

3. You can use descriptive flexfields ATTRIBUTE1 through ATTRIBUTE100 in the 
CN_Commission_Headers table to classify a transaction into a revenue class. In 
order to use the flexfield, Classification Value must be selected for the column 
using the Tables and Columns function. 

4. The Column Datatype must also be set to either numeric or alphanumeric (the 
default is alphanumeric). 

5. You can also specify a Valueset Name. The valueset should be table validated. 
The values in the specified valueset are used in the Value field instead of 
unvalidated data entry when you are defining a rule attribute.

Guidelines
If Oracle Sales Online is used, forecast Compensation in Oracle Sales Online will be 
enabled by calculating Compensation by opportunity. You can forecast 
compensation in the Oracle Sales products with greater accuracy by calculating 
compensation by opportunity. In order to do so, assign attributes in the CN_
COMMISSION_LINES table to Interest Type, Primary Interest, and Secondary 
Interest in Tables and Columns, select Classification Value, and create classification 
rules that use one or more of these attributes.
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Ruleset
Use this screen to create a classification Ruleset and Account Generation.

Prerequisites
Revenue Classes have been created and the user-defined flexfields of the CN_
COMMISSION_HEADERS table have been defined.

Steps
1. In the Navigator, choose Classification Rules > View By Classification Rules.

2. In the hierarchy, right-click Classification Rules and choose New.

The Ruleset window appears.

3. Specify a name for your set of classification rules and assign active start and 
end dates.

4. Select Revenue Classification type.

5. Save the ruleset.

The new ruleset appears in the Navigator.

6. Close the Form and return to the Navigator. 

7. Right-click the ruleset that you have just created and select Add new child Rule. 

The Rules Form will appear. 

8. Define your classification rules on the Rules Form and return to this Form when 
completed.

9. For every Ruleset that has new or changed rules, click Synchronize. 

Ruleset Status displays either Complete if the currently defined revenue classes 
and rules have been synchronized, or Incomplete if you have made changes in 
your definitions since they were last synchronized.

When you click Synchronize, the classification rules package is automatically 
installed in the database using the concurrent program named Install 
Classification Rules Package.

Guidelines
You can define multiple date-effective classification rulesets. Ruleset active dates 
may not overlap.
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A hierarchy of rules can be defined for each ruleset.

Every rule must have at least one attribute.

A rule may or may not have a revenue class. If the rule does not have a revenue 
class, then its children rules must define the revenue class. If a rule has a revenue 
class, then the revenue class is assigned to the transaction only if none of its child 
rules match the transaction.

If you specify high and low values in a rule condition, the values must be numeric, 
not alphanumeric.

Hierarchy Values: Selecting this option allows you to enter the value in the 
hierarchy you want to match. The fields that appear are Hierarchy and Hierarchy 
Values. If the value of the transaction attribute rolls up the hierarchy to the value 
you specify, then the compensation transaction satisfies the condition.

Not: Specify the inverse of a value you defined by checking Not. The compensation 
transaction satisfies the condition if the attribute is not equal to the specified value, 
is not between the range of values specified, or does not roll up to the specified 
ancestor value.

When you add rules and revenue classes, you must synchronize the new rule and 
revenue class definitions before they can be used in compensation plans. You do not 
need to synchronize if you only rearranged the rules.

Always customize the classification rules using the setup forms available. Do not 
modify the generated PL/SQL code.

Troubleshooting
When a transaction fails classification for a rule that uses hierarchy values, the most 
common problem is that the primary key value in the transaction attribute column 
is not the same as the primary key value defined in the hierarchy (the value for the 
EXTERNAL_ID field).

Rules
Use this screen to define the classification rules.

Prerequisites
Classification Ruleset has been created.
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Steps
1. In the Navigator, right-click the Ruleset that you have just created and select 

Add new Child Rule.

The Rules window appears.

2. Assign a name to the rule that you are about to define.

3. Choose a revenue class from the list of values.

4. In the Rule Attributes tab, choose a user column name from the list of values, 
choose the type of values from the drop-down list, and enter the value or values 
that apply.

5. Optionally, enter additional attributes for the rule.

Every attribute is assumed to be linked to other attributes with AND.

6. If you want any of the attributes to be related with OR, use the Build Expression 
tab to relate the first two attributes with AND or OR.

An additional value of Result1 appears in the first column and is added to the 
attribute list of values.

7. Continue to relate the remaining attributes. Use Result1 to relate a third 
attribute to the first two.

8. Save the rule.

The expression appears.

9. To add rules in the hierarchy of rules, position your cursor over the parent rule, 
right click, and choose New Rule. Repeat from step 2.

10. Return to the Ruleset Form for every ruleset that has new or changed rules and 
click Synchronize.

Guidelines
Name your rules after the revenue classes they describe. Rules do not require 
unique names. 
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Defining Other Dimensions

Steps
1. Ensure that the table you base your dimension on exists in the database by 

navigating to the Dimensions window and selecting the list of values in the 
Base Table field. 

By default, choose Dimensions from the Setup menu to open the Dimensions 
window.

2. Define the dimension table in the Oracle Sales Compensation using the Tables 
and Columns form (Setup> Tables and Columns). Enter the table name and 
column names. The dimension table must have a Primary Key and a column 
that stores the actual dimension values.

3. Open the Dimensions window again.

4. In the Name field, enter the name of the new dimension.

5. In the Base Table field, enter the name of the table for the new dimension or 
select the table name from a list of values. (If a table has a dimension based on it 
already, it will not appear in the list of values for this field.

6. In the Primary Key field, enter the name of the column defined as the Primary 
Key in this table (as defined in the Tables and Columns form).

7. In the Dimension Values field, enter the name of the column that stores the 
values that will appear in the hierarchies.

8. Define one or more hierarchies for this dimension and save your work.

Defining a Hierarchy

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.

2. In the Name field, select the dimension for which you are defining a hierarchy.

3. Choose Hierarchies. Use the Hierarchies window that opens to add and view 
hierarchies.

4. Enter the name of the new hierarchy.
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5. Enter the period you want the hierarchy to be effective. Choose From and To 
periods from a list of values. Two hierarchies in the same dimension cannot 
have overlapping periods.

6. Add nodes to a hierarchy. Save your work.

Adding Nodes to a Hierarchy

Steps
1. In the hierarchy, double-click Revenue Classes.

The Hierarchies window displays the revenue class hierarchy type.

2. Select a hierarchy, then choose Nodes. 

Use the window that opens to define the parent-child relationship between all 
nodes in a hierarchy.

3. Start at the top of the hierarchy; define the nodes in your hierarchy.

By default, Oracle Sales Compensation names the highest level root of every 
hierarchy BASE NODE. You can change this name. Use the Current Root menu 
to change the root your are defining.

4. Enter the names of all children of this node. Use the list of values to select the 
children.

5. To define the next level in the hierarchy, select a child node, then choose 
Children.

The ’child’ moves to the Current Node position and Oracle Sales Compensation 
displays the children of the new parent, if they exist.

6. Enter the names of all children of this parent.

7. Choose Parent to go one level up in the hierarchy.

8. Repeat steps 4 through 7 to define all nodes in the hierarchy.

9. Save your work and exit the window.

Deleting Nodes from a Hierarchy

Steps
1. In the Hierarchies window, choose Nodes.
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2. Select the node you want to delete and then choose Delete Record from the Edit 
menu. 

3. Save your work and exit the window.

Setting Up Compensation Plans

Defining Calculation
You can use approximately 165 columns when defining a Calculation expression. 
There are 100 user definable column attributes and approximately 65 hard coded 
columns. You can use these Calculation Expressions as Performance Measures, 
Input Expressions or Output Expressions. You can also nest a Calculation 
Expression within another Calculation Expression.

As part of the definition process you can select the corresponding columns from the 
expression builder and create expressions. Once they have been saved they can be 
assigned and reassigned to any number of formulae you need.

Do this by selecting a valid Expression from a List of Values at each of the screens 
for performance measure, input and output.

A Performance Measure can be an accumulation of transaction values that are 
captured by the Plan Element that it is assigned to. Performance Measures serve as 
a mechanism to gather cumulative information by Plan Element and group them for 
use in reports that compare achievements to Quota, Goal and Performance 
Measure.

An example of a Performance Measure is Revenue. You would select and define the 
columns where revenue information for transactions are held. As transactions are 
entered and collected for the assigned Plan Element, the transaction values are 
accumulated. The Expression would like this:-

TRANSACTION_AMOUNT* EVENT_FACTOR

Inputs of the Formula instruct Sales Compensation what to evaluate from the 
transactions and how to match the results to the corresponding rate table. Think of 
the input expression as a sorter for all incoming transactions for Sales 
Compensation. 
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A sample rate table could look like:

For example, as a condition a company can establish that its sales force will be 
compensated based on transaction amount. The input expression will merely state 
that transactions will be sorted by TRANSACTION_AMOUNT from the CN_
COMMISSION_HEADERS column.

As transactions are ‘sorted’ by through the input expression they are matched to the 
rate table tiers established. If a transaction is collected in Oracle Sales Compensation 
with the following attributes:

1. Customer X

2. Transaction Amount $100

3. Product Z

Oracle Sales Compensation, using the input expression created will match the 
above transaction of $100 with the rate table and determine that 4% will be paid on 
this order. 

Outputs of the formula instruct Sales Compensation how much to pay salespeople. 
The payment amount can either be tied to a rate table or not. This will be 
determined by the users.

In our example above our business users determined that the salespeople will be 
paid based the rate table result, transaction amount, and a constant 
uplift/accelerator factor of 1.035. Users will need to instruct Sales Compensation the 
columns where all this information resides and apply the calculations.

Example of an output expression:

Rate Table Result * (TRANSACTION_AMOUNT * EVENT_FACTOR * PAYMENT_
FACTOR)

Using the above expressions, Oracle Sales Compensation will match what the input 
expression returns as the corresponding rate table result (that is, matching the $100 
transaction amount and coming up with a pay out of 4%), multiply it by the 
transaction amount ($100), multiply with event factor of 100% and multiply with 
1.035 for the payment accelerator or payment uplift.

$0 - $100 4%

$100 - $500 5%

$500 - $99,999 6%
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Total payment due to the salesperson for this transaction will be $4.14.

Forming Calculation Expressions
Use this screen to define calculation expressions or parts of your formula that you 
can re-use in other formulas. 

Prerequisites
None

Steps
1. Choose System from the Menu bar, and select Tables and Columns from the 

drop down menu.

2. Query the Schema and Table name that you want to view. 

For example, if you want to view the CN_COMMISSION_HEADERS, query on 
Schema    CN   and Name      CN_COMMISSION_HEADERS.

The Tables and Columns window displays the selected schema and table.

3. Next to the table, select Use in Calculation.

The columns in the table are listed.

4. Optionally, give each column a business-related user column name for ease of 
identification by the user.

5. Select Calculation Value for each column to be made available for inclusion in a 
calculation.

6. Save your work.

External tables can also be used. Create a Table in any schema in the same 
instance as the application. 

7. In the Menu bar, choose System > External Table. 

8. Register the table by choosing the desired table and saving it.

9. Click the Columns tab. 

10. Click the Primary Key tab and check the primary key box.

11. Enter sequence in sequence field.

12.  In the Menu bar, choose System > External Table.
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13. Enter source table and destination table.

Guidelines
A Commission Formula must include at least one column from the following tables.

� cn_commission_lines

� cn_commission_headers

A Bonus Formula cannot include a column from the following tables or any external 
table that is mapped to thess tables.

� cn_commission_lines

� cn_commission_headers

� cn_srp_period_quotas

A Commission Formula cannot include an element from the table cn_srp_periods or 
any table that is mapped to this table.

A Bonus Formula cannot include an element from the table cn_srp_period_quotas 
or any table that is mapped to this table.

User table names are listed under External Elements in the Calculation Values tree. 
You join an external table to an internal table by mapping them using System > 
External Tables.

A Bonus Formula cannot be used as an embedded formula and cannot be mixed 
with a commission type formula.

Selected columns are accessible in the calculation values tree for use in building 
formulas and performance measures. The user column name is listed in the tree 
rather than the actual column name.

The following Oracle Sales Compensation tables are predefined in the system and 
can be used as calculation values in defining performance measures and formulas:

CN_COMMISSION_HEADERS
CN_COMMISSION_LINES
CN_SRP_QUOTA_ASSIGNS
CN_SRP_PERIOD_QUOTAS
CN_SRP_PERIODS
CN_QUOTAS
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Defining Rate Tables
Rate tables are used to establish compensation percentage rates or fixed amounts 
for different performance levels. The compensation formula and plan element 
determine the type of information to be compared to the rate table as well as how 
the resulting rate is used in the calculation. Use this procedure to define your rate 
tables.

Prerequisites
Rate Dimensions must exist.

Steps
1. In the Navigator, choose Compensation Plans > View By Rate Tables.

2. In the hierarchy, right-click Rate Tables and choose New.

The Rate Tables window appears.

3. Enter a unique name for the Rate Table. Select a Rate Table type, either an 
Amount type or a Percentage type.

4. In the next block select a rate Dimension that you created previously.

5. In the remaining blocks, select each Dimension and enter either your 
commission Amounts or your commission Percentages.

6. Save your Rate Table.

Rate Dimensions
If a commission rate is based on multiple criteria, then a multidimension rate table 
must be created to reflect all criteria: one dimension per one criterion. 

For example, you are giving an added sales incentive for selling products A and B 
in addition to variable commission rates based on revenue. Your formula first 
compares revenue against a dimension of commission percentages. This dimension 
must be dimension 1. Next your formula compares sold volume of product A with a 
fixed fee dimension based on volume. This dimension must be dimension 2. 
Product B needs a separate dimension to compare with sales volume, which is 
dimension 3.

A dimension contains rate tiers to establish different levels of achievement to be 
compensated at different rates. See the following table for an example of a 
dimension with rate tiers.
66 Oracle Sales Compensation Implementation Guide



Setting Up Compensation Plans
Your minimum and maximum values in the Rate Tiers section must be stated in 
terms consistent with your input information.

You can change both the tiers and rates for a rate table. Any changes you make are 
propagated to all plan elements to which those rate tables are assigned, and thus to 
any salespeople that use plans containing those plan elements. If you change the 
levels of quota achievement in a tier, or add or delete a tier in a rate table, those 
changes propagate to all salespeople, regardless of whether their plans have custom 
quotas or rates. 

In the following example there are three dimensions containing three tiers each. A 
total of 27 rates needs to be defined. In the following table the steps required to 
define the 27 rates are shown. Dimension 3 is chosen as the primary dimension. At 
step 2 a different tier is chosen for dimension 2 and related rates in dimension 3 are 
entered.

Dimension

Revenue

0 - 10,000

10,000 - 25,000

25,000 - 50,000

50,000 - 

Dimension and Rates Example

Dimension 1 Dimension 2 Dimension 3 Rate

Dimensions

1-2 10-20 100-200

2-3 20-30 200-300

3-4 30-40 300-400

Step 1

1-2 10-20 100-200 1

200-300 2

300-400 3

Step 2
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1-2

20-30

100-200 4

200-300 5

300-400 6

Step 3

1-2

30-40

100-200 7

200-300 8

300-400 9

Step 4

2-3

10-20 100-200 10

200-300 11

300-400 12

Step 5

2-3 20-30

100-200 13

200-300 14

300-400 15

Step 6

2-3

30-40

100-200 16

200-300 17

300-400 18

Step 7

3-4

10-20 100-200 19

200-300 20

300-400 21

Step 8

3-4

20-30

100-200 22

200-300 23

300-400 24

Dimension and Rates Example

Dimension 1 Dimension 2 Dimension 3 Rate
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Prerequisites 
None

Steps
1. In the Menu bar, select Tasks > Rate Dimensions.

2. Assign a unique name to your Dimension.

3. Select either Amount or Percentage type. The type chosen determines how you 
express your achievement levels.

4. Enter its description.

5. In the next block, enter the amounts or the percentages in ascending order.

6. The Tier Sequence will be numbered automatically as you progress through 
each level of achievement.

Creating Formulas
You have complete flexibility to create formulas for calculating compensation. Your 
formulas can be used in another formula definition or in a plan element definition. 
Use this procedure to create formulas.

You can save an incomplete formula and return to complete it later.

Prerequisites
If you wish to incorporate Calculation Expressions into your formula, then these 
Expressions must be created before you reach this stage. These Expressions can be 
repeated in your formula and can also be reused in other formulas as well. Please 
see Guidelines on the types of Calculation Expressions that you can use for 
Commission and Bonus Formulas.

Step 9

3-4 30-40

100-200 25

200-300 26

300-400 27

Dimension and Rates Example

Dimension 1 Dimension 2 Dimension 3 Rate
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Any column from any table can be part of your formula, providing the Calculation 
Value check box for the column is selected in Columns and Tables. (See Defining 
Calculation.)

Rate tables must be created first if you want to include them in your formula. (See 
Defining Rate Tables.)

Steps
1. In the Navigator, choose Compensation Plans > View by Formula.

2. In the hierarchy, right-click Formulas and choose New.

3. In the general tab, enter a unique name and a description for your Formula.

4. Decide whether your Formula is for calculating a Commission or a Bonus. 
Make your selection at Type.

5. In the next block, determine your calculation rules.

6. In the last block, select a Calculation Expression that will become your 
Performance Measure. Performance Measure as well as Quota will be used in 
Reports for comparison with achievement.

7. In the Input tab, select a Calculation Expression to represent your input 
formula. The number of Input Calculation Expressions must equal the number 
of Dimensions in the Rate Table that you will select in the next step.

8. If applied rates are part of your formula, then in the Rate Table tab, select the 
rate tables to apply to the formula and enter their effective start and end dates. 
You can view the Rate Table details and rates for each dimension by clicking on 
the Rate Table Details button.

9. In the Output tab, select your output Calculation Expression.

10. Return to the General tab and click Generate. On completion, the validation 
process will return a Complete status.

Guidelines
A Bonus Formula is a type of Formula where there are no links or references to 
transactions. See Guidelines for Calculation Expressions.

Apply transactions individually if you want each transaction calculated separately 
to determine a rate. Group transactions if you want transactions aggregated to 
determine the rate.
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Tick the Accumulative checkbox if transactions are required to be aggregated in 
total. Rate applied will be determined by the transactions-total achieved to date 
within the interval.

Use interval to date quotas and fixed amounts if:

� Calculation is to occur before the end of the plan element interval (for example, 
if the interval is quarter and calculation occurs monthly)

� Quotas are set cumulatively within the interval

� Performance to date is to be compared to the quota to date

Choose Thresholds if you want all prior transactions within the interval paid 
retroactively at the higher rate once that higher rate is achieved through 
accumulative transactions.

Do not split tiers if you want a rate from the Rate Table applied to the full amount. 
Split tiers if you want portions of the full amount paid at each rate up to the top 
qualifying rate. For example, the Rate Table shows 0-1000 at 1%, 1000-2000 at 2%. 
The transaction amount is 1500. If you tick the No Split checkbox, 2% will be 
applied to the whole transaction amount of 1500. If you tick the Non Proportional 
checkbox, 1% will be applied to 1000 and 2% will be applied to 500.

The Proportional checkbox is intended for use with Amount Rate Tables. Example, 
if the Rate Table shows 0-1000 at 100, 1000-2000 at 200. The first transaction amount 
is 200. The commission for this transaction is 20 because 200 is one fifth of the first 
rate tier and one fifth of the 100 rate is 20. If the second transaction amount is 1300, 
the remaining four fifths of the first rate tier will pay 80 and half of the second tier 
[(1300-800)/(2000-1000)] will pay 100 (half of the rate 200). Total commission for the 
second transaction is 180.

Defining Plan Elements
A plan element is a set of conditions a salesperson must meet to be eligible for 
compensation. It determines how the compensation is calculated. Use this 
procedure to define plan elements.

Prerequisites
If the plan element includes a formula, then the formula must be created first. (See 
Creating Formulas.)

If the plan element includes a rate table, then the rate table must be created first. 
(See Defining Rate Tables.)
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If the plan element includes a revenue class, then the revenue class must be defined 
first. (See Creating Revenue Classes and Hierarchies.)

Steps
1. In the Navigator, choose Compensation Plans > View By Plan Elements.

2. Right-click on Plan Elements and select new.

3. In the General tab, in the first block:

� Enter a unique name for your Plan Element.

� Enter its Start and End dates.

� Enter a description of its objective.

� You may copy from an existing Plan Element by clicking on the Copy Plan 
Element button to make a duplicate of the displayed Plan Element. The name is 
changed with a “_2” attached to the end of the Plan Element name. You may 
over-write with a new name if you wish, before saving the new Plan Element.

� To start a new Plan Element, click on the New Plan Element button.

� In the Quota Group field, select either Quota or Bonus. If you select Quota, this 
Plan Element will appear in the top half of the YTD Summary Report. If you 
select Bonus, then this Plan Element will appear in the lower half of the YTD 
Summary Report.

4. In the second block of the General tab: 

� Select the Interval, Incentive type, Credit type, Formula type and a Formula. If 
you choose External Formula type, you must enter the name of the PL/SQL 
procedure. If you choose Formula type, select a Formula that has a Complete 
status.

� If you want the Plan Element and the eventual payment to be assigned to 
someone other than the Salesperson credited with the sale, tick the Eligible for 
Payee Assignment checkbox. 

� Tick the Calculate Last checkbox if you want this Plan Element to be calculated 
after all the other Plan Elements assigned to the same Compensation Plan as 
this Plan Element is, are calculated.

� Select Liability and Expense Account codes information that you want sent to 
Oracle Accounts Payable Invoice Interface Table for all future commission 
payments relating to this Plan Element.
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5. In the last block of the General tab, enter the Quota, Fixed Amount, and Goal 
figures. These are measures that will be used to compare against actual 
achievements. If you have Quota, Fixed Amount and Goal figures against 
individual Revenue Classes assigned to this Plan Element, you can tick the Sum 
amounts from Revenue Classes checkbox and the totals will appear in these 3 
fields. The Distribute Variables button will be available once a Formula with 
Interval to Date checked is assigned to your Plan Element. The Distribute 
function allows you to seasonalize your Quota, Fixed Amount and Goals.

6. In the Revenue Classes tab, assign your Revenue Classes to this Plan Element. 
You may have Quota and Payment Accelerators at Revenue Class level for an 
effective period that you can specify through the Start and End Dates. Ensure 
that your Transaction or Event factors add up to 100% in total. Example, you 
can have 50% of the Order value calculated for commission, 20% of the Invoice 
value and 30% of the Payment amount for commission calculation. Other 
Factors do not need to total 100% and each can be over 100% if you require.

7. The Formula tab will display the Formula that you have assigned under the 
General tab earlier.

8. Similarly, the Rate Table tab will display the rates associated with the Formula.

9. Save your new Plan Element so that it will be available for assigning to a 
Compensation Plan.

Guidelines
You can assign multiple plan elements to a compensation plan, and you can assign 
the same plan element to multiple compensation plans.

When you change the structure of a plan element, it applies to every compensation 
plan that uses it and for every salesperson assigned to that plan. The affected 
compensation plans must again be validated.

The Plan Element’s effective dates must be within the dates of the compensation 
plans to which the plan element is assigned.

You can change any part of a plan element before it is assigned to a salesperson. 
Any changes you make are propagated to all plans to which those plan elements are 
assigned, and thus to any salespeople that use those plans.

Once a compensation plan has been assigned to a sales role, you cannot change the 
plan’s interval type. If you have assigned the plan and you want to change the 
interval for a plan element, you must remove the plan assignment, change the plan 
element’s interval, then reassign the compensation plan.
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How the Accelerators and transaction factors are used will depend on how your 
Calculation Expression is defined. Example, a common Formula is to have an Input 
Expression =

TRANSACTION_AMOUNT* EVENT_FACTOR* QUOTA_FACTOR; 

and an Output Expression = 

Rate_ Result* TRANSACTION_AMOUNT* EVENT_FACTOR* PAYMENT_
FACTOR. 

You will find both Accelerators and the Transaction factors/Event factors under 
Oracle Sales Compensation Elements. 

Defining Compensation Plans
A compensation plan is built from plan elements and is assigned an effective start 
and end date. The plan can then be assigned to multiple sales roles.

Use this procedure to define a compensation plan.

Prerequisites
Plan elements and formulas must be created if they are to become part of the 
compensation plan.

Steps
1. In the Navigator, choose Compensation Plans > View By Plan Elements.

2. In the hierarchy, right-click Compensation Plans and choose New.

The Compensation Plans window appears.

3. Assign a unique name to the new compensation plan.

4. Assign start and end dates to the plan.

5. Enter the objective description for this plan based on the associated sales role. 
The description is used as part of a contract for the salesperson.

6. Tick the Allow Revenue Class overlap checkbox if you want your Plan Elements 
to use the same Revenue Classes. 

7. Select plan elements to be included in the plan and assign each plan element 
effective start and end dates.

8. Optionally, select a plan element and click Element Details to review plan 
element details.
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The Plan Element window displays the selected plan element information.

9. Click Validate to ensure that you have entered the plan information correctly. 

When you validate a compensation plan, the following are verified:

� The plan has a name and start and end dates

� The plan has one or more plan elements assigned with start and end dates 
within the plan start and end dates

� Each plan element has a rate table with contiguous tiers and with start and 
end dates within the plan start and end dates

� Each plan element has at least one revenue class assigned that has start and 
end dates within the plan start and end dates

� Each plan element has a rate table structure that makes sense for the plan 
element type

� Each revenue class has at least one key transaction factor and at least one 
other transaction factor

If each of the above conditions is true, then the Status field shows Complete. 
When the Status field displays Incomplete, the plan cannot be used to calculate 
compensation.

10. Save the plan.

When you save a plan, the values of that plan become the default values when 
you assign it.

11. Optionally, edit the start and end dates for individual salespeople. When the 
compensation plan is assigned to a sales role, the sales role and salespeople 
assigned to the sales role display in the compensation plan window. (See 
Defining Sales Roles.)

Guidelines
Consider defining plan names by job titles or area of sales you are compensating.

When you assign a plan to a salesperson, you define assignment start and end 
effective dates between which the salesperson is on that plan. Because you can 
assign the same plan to many salespeople, ensure the plan period is broad enough 
to encompass all necessary assignment periods. 

You can change or restructure any aspect of a compensation plan. Because you can 
assign the same plan to many salespeople, however, ensure you are aware of how 
the changes you are making impacts individual salespeople.
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When you change a compensation plan, the changes propagate to the salespeople 
assigned to the plans. For customized plans, the salesperson receives all changes 
except the customized changes. If a change is made to a tier in a rate dimension, 
then the new rates overwrite customized rates.

Customizing Compensation Plans
You can customize each plan element in the compensation plan for an individual 
salesperson. Use this procedure to customize a compensation plan.

Prerequisites
None

Steps
1. Choose Salesperson from the Navigator. The Salespeople Workbench appears.

2. In the Compensation Plans tab, select a sales role.

The compensation plans and plan elements for the salesperson and sales role 
appear.

3. Select Customized next to the plan element to be customized.

If you leave the Customized check box unchecked for a plan element, then any 
changes you make to the quota or rates for that plan element are inherited by 
the salesperson.

4. Select the plan element name and click Details.

The Plan Element window displays the details for the plan element.

5. Edit the details to customize the plan. See the table under References for a list of 
fields that can be changed and where they can be found in the plan element 
tabs.

6. Save your changes.

Guidelines
Although you can customize the rates for individual salespeople, those 
representatives automatically inherit all changes made to other aspects of the 
compensation plan itself. For example, if you customize compensation rates for a 
salesperson and then delete a bracket in the rate table assigned to that 
compensation plan, then the salesperson’s rates default to those in the new rate 
table.
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If you change the levels of quota achievement in a tier, or add or delete a tier in a 
rate table, then those changes propagate to all salespeople, regardless of whether 
their plans have custom quotas or rates.

Setting Up Payment
Pay Groups allow control over the frequency of payment for the members of the 
group. Payment Plans allow control over the payment amounts at a Salesperson 
level for all Salespeople who have the specific Payment Plan assigned to them. The 
Transaction Details screen will allow controlled recovery or a payment hold at 
transaction level. In addition the Transaction Details screen will also allow you to 
decide which transactions get paid as part of each Payrun.

This version of Sales Compensation introduces Oracle Accounts Payable 
integration. The integration allows you to pay your Suppliers, Agents or Brokers 
(also referred to as Salespeople and Resources in this Guide) through Oracle 
Accounts Payable payment processes.

Oracle Accounts Payable will only recognize the Salespeople for payment if they are 
activated as Suppliers through Oracle Purchasing. Please refer to Oracle Purchasing 
Guides for the activation procedure.

Defining Pay Groups
A pay group defines the frequency of payments, such as monthly or semi-monthly, 
for the salespeople who are assigned the pay group. Use this procedure to define 
pay groups.

Prerequisites
Calendars and related pay periods must be defined in GL and activated in Sales 
Compensation. 

Steps
1. In the Navigator, choose Payment Setup > View By Pay Groups.

2. In the hierarchy, right-click Pay Groups and choose New.

The Pay Groups window appears.

3. Assign a unique name to the pay group and enter a description.

4. Select effective start and end dates for the pay group.
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5. Select a calendar from the list of values.

6. Select a period type from the list of period types that were defined for the 
selected calendar.

The grid displays all pay periods for the selected calendar and period type that 
fall within the effective date range.

The Sales Representatives tab displays all salespeople who have been assigned 
the pay group using the Salesperson Workbench.

7. Save the pay group.

Guidelines
The period type defines the frequency of payments for the pay group. 

Each pay group can have one or many pay periods. A pay period is a range of dates 
over which calculated plan element commissions are collected for payment.

Defining Payment Plans
Use payment plans to set rules governing how much is paid. Payment plans are 
optional and are used to set up advance or deferred payments. Use this procedure 
to define minimum and maximum payments and controlled recovery.

Prerequisites
Credit types must be defined.

Steps
1. In the Navigator, choose Payment Setup > View By Payment Plans.

2. In the hierarchy, right-click Payment Plans and choose New.

The Payment Plan window appears.

3. Assign a unique name to the payment plan.

4. Optionally, establish a minimum amount to be paid at the end of each pay 
interval, and whether or not it is recoverable from later commissions.

5. Optionally, establish a maximum amount to be paid at the end of each pay 
interval.

6. Optionally, establish a maximum amount that can be recovered in each pay 
interval.
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7. If you want any commission earned above the maximum payment to be 
included in a later pay run, then select Pay Later.

8.  Save the payment plan.

The payment plan is available to be assigned to a salesperson in the workbench.

Guidelines
The application checks first for the minimum amount and pays it. Recoverable 
amounts are calculated after the minimum is met.

Account Generator
Expense and Liability Account information will be supported by default at three 
levels:

� REVENUE CLASS

� PLAN ELEMENT

� TRANSACTION

If the transaction level option is chosen then the following setup has to be done 
similar to the current classification Ruleset procedure:

Define a Ruleset of the type ‘Liability Account Mapping’. Define rules for this 
Ruleset by selecting the columns of transaction that determine the segments and 
thus the code combination id that forms its rule attributes. The classification 
package will be generated and the appropriate package will be invoked by the 
payment submission package that obtains the liability code dynamically based on 
the liability account mapping setup.

Sample Summary Reports
See sample Summary Reports in the Appendix to this Guide. 
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OSC Summary Reports

Performance

1. Compensation Summary
2. Blind Ranking Report
3. Top/Bottom Performers Report
4. Compensation Details
5. Sales Credit Reports
6. Performance Details Report
7. Compensation Details (Fiscal View)
8. Performance Details (Fiscal View)
9. Compensation Trending Report

Operational

1. Adjustments Report
2. Compensation Group Hierarchy Report
3. Salespeople Hierarchy Report
4. Analyst Compensation Consolidated Summary
5. Payrun Listing
6. Payee Report
7. Classification Rules Report
8. Payrun Details

Exception

Payment Hold Report
Pending Payment Report
Pending Transactions Report
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Adjustment Report
This report indicates adjustments and status for compensation.

Some fields are user definable and some can be queried. Enter your information for the basic parameters. Follow the example below,
which illustrates the requirements for basic parameter setup.

You can select attribute1- 6 columns from the base table and display values for these columns as output to this report. You can enter
messages that will appear at the bottom of a report.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names and the
extra choice ‘All’. Once a value is selected in
the salesperson name field the salesperson
number should be automatically populated
also.

All Y NAME

Salesperson Number LOV - All the salespersons’ numbers  and the
extra choice ‘All’. Once a value is selected in
the salesperson number field the salesperson
name should be automatically populated also.

All Y EMPLOYEE_NUMBER

Process Date From No LOV - The calendar  feature should be
used.

N CALANDER WIDGET

Process Date To No LOV - The calendar feature should be
used. This parameter can hold a date no
earlier than that entered in the process date
from parameter  field. You still need to be
able to enter a date in this parameter if the
Process Date from parameter is null.

N CALANDER WIDGET

Invoice Number LOV - All the invoice numbers and the extra
choice ‘All’. This LOV should be restricted if
an individual  salesperson is chosen to only
those invoices applicable to that salesperson.
If the process date parameters are used this
parameters LOV should be restricted further
to only the applicable invoice numbers. If
the order number parameter has been entered
this LOV should be restricted further to valid
corresponding invoice numbers.

All Y INVOICE_NUMBER

Order Number LOV - All the order numbers and the extra
choice ‘All’. This LOV should be restricted if
an individual  salesperson is chosen to only

All Y ORDER_NUMBER
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those orders applicable to that salesperson.
If the process date parameters are used this
parameters LOV should be restricted further
to only the applicable order numbers.

Calculation Status LOV - All the calculation statuses and the
extra choice ‘All”.

All Y SELECT MEANING
FROM CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘TRX_STATUS’

Adjustment Status LOV- All the adjustment statuses and the
extra choice ‘All’

All Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘ADJUST_STATUS’

Adjustment Date No LOV - The calendar feature should be
used.

N CALENDER WIDGET
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Data

Column Descriptions

The following table describes each column to be included in the Adjustments Report.

Column Title Description Value
Length

Column Name/Formula

Salesperson Name The salespersons name for the required
adjustment.

40 DIRECT_SALESREP_ID

Salesperson Number The salespersons number for the required
adjustment.

30 DIRECT_SALESREP_NUMBER

Process Date The adjustment process date. 11 PROCESSED_DATE
Transaction Type The adjustment transaction type 20 TRX_TYPE
Order Number The adjustment order number 15 ORDER_NUMBER
Order Date The adjustment order date 11 ORDER_DATE
Invoice Number The adjustment invoice number 15 INVOICE_NUMBER
Invoice Date The adjustment invoice date 11 INVOICE_DATE
Currency Code The adjustment currency code 20 CURRENCY_CODE
Adjustment Status The adjustment status 30 ADJUST_STATUS
Calculation Status The adjustment calculation status 30 STATUS
Transaction Amount The adjustment transaction amount 20 TRANSACTION_AMOUNT_ORI

G
Commission Amount The adjustment commission amount. 20 COMMISSION_AMOUNT
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Layout/Graphics

Salesperson Name Salesperso
n Number

Process
Date

Transaction Type Order
Number

Order Date Invoice
Number

Invoice
Date

Currenc
y Code

Adjustme
nt Status

Calculatio
n Status

Transacti
on
Amount

Commissi
on
Amount

Bob Wiley 11 15-Jun-1999 Manual Transaction 5721141 15-Jun-1999 254457 16-Jun-1999 USD Frozen Calculated 75,000 7,500
Barry Lewis 44 15-Jun-1999 Manual Transaction 5781154 15-Jun-1999 278615 16-Jun-1999 USD Frozen Calculated 15,000 1,500
Delores Smith-Jones 45 15-Jun-1999 Manual Transaction 5211247 15-Jun-1999 236974 16-Jun-1999 USD Frozen Calculated 25,000 2,500
Elaine Manley 46 15-Jun-1999 Manual Transaction 5247999 15-Jun-1999 236799 16-Jun-1999 USD Frozen Calculated 78,520 7,852
Howard Sprague 47 15-Jun-1999 Manual Transaction 7551121 15-Jun-1999 235449 16-Jun-1999 USD Frozen Calculated 45,000 4,500
Jerrold Feinberg 48 15-Jun-1999 Manual Transaction 6842154 15-Jun-1999 254779 16-Jun-1999 USD Frozen Calculated 150,000 15,000
Lisa Douglas 49 15-Jun-1999 Manual Transaction 5219547 15-Jun-1999 221487 16-Jun-1999 USD Frozen Calculated 45,000 4,500
Pat Murphy 50 15-Jun-1999 Manual Transaction 9644842 15-Jun-1999 214577 16-Jun-1999 USD Frozen Calculated 3,000 300

Consolidated Compensation Summary Report
This is the key report for compensation analysts. It shows all sales credits that make up the commission/bonus amounts. The
salesperson name figures link to the Compensation Summary Report. Total gross pay figures link to the Payrun Detail Report. Total
Pending figures link to the Pending Transaction Report.

Enter your information for the basic parameters. The example below illustrates the requirements for basic parameter setup.
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Figures displayed in this report are in the salesperson’s functional currency. You can export the information for some fields by using the
‘export to excel function’.

You can enter messages that will appear at the bottom of a report.

Parameters

Prompt Choices Available Default Value Mandatory LOV - Column
Name/Formula

Analyst Group LOV - List of all analyst groups
and the extra choice ‘ALL’.

ALL Y NAME

Reporting Period LOV - List of all reporting periods
available and the extra choice
‘ALL’. The LOV is restricted to
the analyst group selected.

ALL Y PERIOD_NAME
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Data

Column Descriptions

The following table describes each column to be included in the Analyst Compensation Summary Report.

Column Title Description Value
Length

Column
Name/Formula

Functional Currency
Type

The functional currency that all the figures
are displayed in.

20 ?

Salesperson Name The salesperson’s name assigned to the
selected analyst group

30 NAME

Salesperson Number The salesperson’s number assigned to the
selected analyst group.

10 EMPLOYEE_NUMBER

Salesperson Type The salesperson’s type assigned to the
selected salesperson in the analyst group.

20 TYPE

Sales Role The role assigned to the salesperson in the
selected analyst group.

20 NAME

Credit Type The credit type for the compensation
calculation.

10 NAME

Commission Commission salesperson earned for this
period. Value obtained from the Salesperson
Worksheet.

15 COMMISSION_EARNED_PTD

Bonus Bonus salesperson earned for this period.
Value obtained from the Salesperson
Worksheet.

15 BONUS_EARNED_PTD

Other Other payments salesperson will receive for
this period. Value obtained from the
Salesperson Worksheet.

15 OTHER_EARNED_PTD

Subtotal Subtotal of Commission, Bonus and Other .
Value obtained from the Salesperson
Worksheet.

25 COMMISSION_EARNED_PTD
+
BONUS_EARNED_PTD+
OTHER_EARNED_PTD

Advance Advances to be applied to the salesperson for
this pay period. Value obtained from the
Salesperson Worksheet.

15 ADVANCE_COMMISSION_PT
D

Total Gross Pay Total of the Subtotal amount less Advance
figure.

30 COMMISSION_EARNED_PTD
+
BONUS_EARNED_PTD+
OTHER_EARNED_PTD+
ADVANCE_COMMISSION_PT
D

Commission Pending Pending Commission salesperson earned for
this period. Value obtained from the
Salesperson Worksheet.

15 COMMISSION_PENDING_PT
D
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Column Title Description Value
Length

Column
Name/Formula

Bonus Pending Pending Bonus salesperson earned for this
period

15 BONUS_PENDING_PTD

Total Pending Total of Pending Commission and Pending
Bonus.

25 COMMISSION_PENDING_PT
D+ BONUS_PENDING_PTD
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Layout/Graphics

Functional Currency Type :Dollar

Salesperson
Name

Salesperso
n Number

Salesperso
n Type

Sales Role Credit
Type

Commission Bonus Other Subtotal Advance Total
Gross Pay

Commission
Pending

Bonus
Pendin
g

Total
Pending

Bob Wiley 11 Employee Full Time Agent Cash 7,879 15,000 0 22,879 0 22,879 15,000 0 15,000
Barry Lewis 44 Employee Full Time Agent Cash 10,500 10,000 0 20,500 0 20,500 12,000 0 12,000
Delores Jones 45 Employee Full Time Agent Cash 11,750 10,000 0 21,750 0 21,750 17,000 0 17,000
Elaine Manley 46 Other Contractor Cash 54,000 0 0 54,000 14,000 40,000 0 0 0
Howard Sprague 47 Other Contractor Cash 75,000 0 0 75,000 15,000 60,000 0 0 0
Jerrold Feinberg 48 Other Contractor Cash 86,530 0 0 86,530 16,500 70,030 0 0 0
Lisa Douglas 49 Other Contractor Cash 12,500 25,000 0 37,500 0 37,500 10,000 0 10,000
Pat Murphy 50 Other Contractor Cash 17,250 15,000 0 32,250 0 32,250 0 0 0

Blind Ranking Report
This performance report ranks members of a sales force with their peers and is used primarily by sales management. The user can
choose the standards and measures to run. Compensation analysts use this report to find a salesperson’s earnings and sales credits.
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The report graphics and layout follow the same format as the existing report with the exception of “Measures”. This report uses security for
salesperson and sales management: A salesperson can access only his/her own data and a manager can access data for all people below them in the
hierarchy.

Users can enter messages that will appear at the bottom of a report. They can export the information for some fields of this report by using the
‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV- All the salespersons’ names and their
employee numbers. If not entered a salesperson
number must be entered. Once a value is selected
in the salesperson name field the salesperson
number should be automatically populated also.

The person
that logged
in.

Y NAME

Salesperson Number LOV - All the salespersons’ numbers. If not
entered the salesperson name must be entered.
Once a value is selected in the salesperson
number field the salesperson name should be
automatically populated also.

The person
that logged
in.

Y EMPLOYEE_NUMBER

Salesperson Type LOV - List of all the salesperson types available
for this salesperson. Examples are employee and
other. This LOV is restricted to the salesperson
types applicable to the salesperson and sales role
selected.

Employee Y TYPE

Sales Role LOV - All roles available for this salesperson.
This LOV is restricted to the salesperson
selected.

Y NAME

Reporting Date No LOV - The calendar widget should be used. Y CALENDAR WIDGET
Measure 1 Choose up to 3 measures by which you want to

rank the salesperson. The LOV should be limited
to the measures used on this sales role’s
compensation plan). For instance, revenue, # of
sales calls, customer satisfaction, units, revenue
growth % etc. Values are user-defined.

A User
definable
default
value is
required.

Y NAME

Measure 2 Choose up to 3 measures by which you want to
rank the salesperson. The LOV should be limited
to the measures used on this sales role’s
compensation plan). For instance, revenue, # of
sales calls, customer satisfaction, units, revenue
growth % etc. Values are user-defined.

A user
definable
default
value is
required.

N NAME

Measure 3 Choose up to 3 measures by which you want to
rank the salesperson. The LOV should be limited

A user
definable

N NAME
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to the measures used on this sales role’s
compensation plan). For instance, revenue, # of
sales calls, customer satisfaction, units, revenue
growth % etc. Values are user-defined.

default
value
maybe
required.
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Data

Column Descriptions

The following table describes each column to be included in the Blind Ranking Report. The report graphics and layout follow the same
format as the existing report with the exception of “Measures”.

Column Title Description Value
Lengt

h

Column
Name/Formula

<Measure> (My Amount /
Maximum)%

This is the salespersons performance percentile for
measure 1, measure 2 and measure 3 against all the
other relevant salespeople with the selected role for
the stated period.

10 New formula dependant on the
measure that is selected. This
functionality needs to be
investigated.
PERF_ACHIEVED_PTD

<Measure> Rank The position that a salesperson was ranked against
all other relevant salespeople with the selected role
and for the stated period.

20 New formula that is dependant
on the measure that is
selected. This functionality
needs to be investigated.
PERF_ACHIEVED_PTD
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Layout/Graphics

Example One :
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(My
Amount/

Maximum)
%

Rank

<Measure 1> 100% 1 out of 6
<Measure 2> 58% 4 out of 6
<Measure 3> 88% 2 out of 6
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Example Two :
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(My
Amount/

Maximum)
%

Rank

Incremental
Growth

100% 1 out of 6

Revenue 63.4% 2 out of 6
# of Calls 67.3% 2 out of 6
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Compensation Group Hierarchy Report
This report displays any compensation group hierarchy specified by users as of any date. The Compensation Group fields link to the
Salespeople Hierarchy Report.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using
the ‘export to excel function’.

Query results show the parent compensation groups/children compensation groups of the search criteria (the compensation group
name) all the way to the top/bottom of the hierarchy (direct path). The search criteria phrase is displayed in a different color in the
report results so that it stands out from the rest of the rule names. The effective dates for a selected compensation group name are also
displayed in a different color.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Compensation Group
Name

LOV - All the compensation
group names and the extra choice
‘ALL’.

ALL Y NAME

Effective Date No LOV - The Calendar feature
should be used.

Current date Y CALANDER WIDGET

Data

Column Descriptions

The following table describes each column to be included in the Compensation Group Hierarchy Report.

Column Title Description Value
Length

Column
Name/Formula

Compensation Group
Names

Display the name of the Compensation Group
which is in the hierarchy.

40 NAME

Effective Dates The compensation group effective date from 26 START_DATE_ACTIVE||
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Column Title Description Value
Length

Column
Name/Formula

field concatenated with the compensation
group effective date to field.

END_DATE_ACTIVE



OSC Summary Reports
SCReprts.doc  (v. 1.0) Oracle/Client Confidential - For internal use only

21

Layout/Graphics

Example One:

Compensation Group Names Effective Dates
Oregon 01-Jun-1999 - 28-Feb-1999

West Coast Area 01-Jun-1999 - 28-Feb-1999
West Portland Area 01-Jun-1999 - 28-Feb-1999

Portland 01-Jun-1999 - 28-Feb-1999
Northside 01-Jun-1999 - 28-Feb-1999
Eastside 01-Jun-1999 - 28-Feb-1999

San Francisco 01-Jun-1999 - 28-Feb-1999
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Example Two:

Compensation Group Names Effective Dates
Oregon 01-Jun-1999 - 28-Feb-1999

West Coast Area 01-Jun-1999 - 28-Feb-1999
West Portland Area 01-Jun-1999 - 28-Feb-1999

Portland 01-Jun-1999 - 28-Feb-1999
Northside 01-Jun-1999 - 28-Feb-1999
Eastside 01-Jun-1999 - 28-Feb-1999
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Compensation Details Report
This report is used primarily by the salesperson and sales manager. It shows plan element details of commission, bonus, and
achievement levels by performance measure against quota and goal.

This report mirrors the information provided on the Compensation Detail screen and links to the Compensation Summary, the
Compensation Trend Reports, and further detail in the Sales Credit report. The <Plan Element Name> fields link to the Performance
Details report.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using
the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. If not
entered the salesperson number must be entered.
Once a value is selected in the salesperson name
field the salesperson numbers should be
automatically populated also.

The person
who has
logged in.

Y NAME

Salesperson Number LOV - All the salespersons’ numbers. If not
entered the salesperson name must be entered .
Once a value is selected in the salesperson
number field the salesperson name should be
automatically populated also.

The person
who has
logged in.

Y EMPLOYEE_NUMBER

Salesperson Type LOV - List of all the salesperson types available
for this salesperson. Examples are Employee and
Other. This LOV is restricted to the salesperson
types applicable to the salesperson and role
selected.

Employee Y TYPE

Salesperson  Role LOV - All roles available for this salesperson,
user should be able to pick ‘All’, which would
represent a summary of all of their roles
together.  This LOV is restricted to the roles
applicable to the salesperson selected.

ALL Y NAME

Reporting Period LOV - List of all accumulated periods available.
The LOV is restricted to the role and
salesperson.

Y PERIOD_NAME

Currency Type Functional or Salesperson currency Default to
the
salesperson
currency.

Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’



OSC Summary Reports
SCReprts.doc  (v. 1.0) Oracle/Client Confidential - For internal use only

24

Credit Type LOV - List of all the credit types available for
this salesperson. This LOV is restricted to the
appropriate values for the salesperson and role
selected.

Y NAME

Compensation Plan LOV - List of all the compensation plans
restricted by the information entered in all the
other parameter fields. This is the only “new”
parameter when drilling down from the
Commission Summary Report the other
parameters should default.

Y NAME
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Data

Column Descriptions

The following table describes each column to be included in the Compensation Details Report.

Column Title Description Value
Length

Column Name/Formula

Summary (Current
period) Commission
<Plan Element>
Incentive Amount

The incentive amount of commission earned by the
salesperson during this period for the stated plan
element. (Incentive type = Commission)

10 COMM_PAYED_PTD

Summary (Current
period) Commission
<Plan Element>
Measure Amount

The selected measure amount of commission earned by
the salesperson during this period for the stated plan
element. Revenue, Units, Customer Retention.

10 PERF_ACHEIVED_PTD

Summary (Current
period) Commission
<Plan Element>
Quota Achievement
%

The percentage of quota achieved for the stated
salesperson during this period for the stated commission
plan element. Measure/Quota * 100

10 (PERF_ACHIEVED_PTD/TARG
ET_AMOUNT)*100

Summary (Current
period) Commission
<Plan Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated commission
plan element. Measure/Goal * 100

10 (PERF_ACHIEVED_PTD/PERF
_GOAL_PTD)*100

Summary (Current
period) Bonus <Plan
Element> Incentive
Amount

The incentive amount of bonus earned by the
salesperson during this period for the stated plan
element. (Incentive type = Bonus)

10 COMM_PAYED_PTD

Summary (Current
period) Bonus <Plan
Element> Measure
Amount

The selected measure amount of bonus earned by the
salesperson during this period for the stated plan
element.

10 PERF_ACHIEVED_PTD

Summary (Current
period) Bonus <Plan
Element> Quota
Achievement %

The percentage of quota achieved for the stated
salesperson during this period for the stated bonus plan
element.

10 (PERF_ACHIEVED_PTD/TARG
ET_AMOUNT)*100

Summary (Current
period) Bonus <Plan
Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated bonus plan
element.

10 (PERF_ACHIEVED_PTD/PERF
_GOAL_PTD)*100

Advances Beginning
Balance

The balance in advances that have not yet been earned.
This information can be found on the Compensation
Summary screen.

15 (:ADVANCE_TO_REC_ITD -
:ADVANCE_RECOVERED_ITD
+
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Column Title Description Value
Length

Column Name/Formula

:RECOVERY_AMOUNT_ITD) -
(:ADVANCE_TO_REC_PTD -
:ADVANCE_RECOVERED_PT
D +
RECOVERY_AMOUNT_PTD);
Summarized by salesperson.

Advances Current The amount of advances paid in the current period -
This information can be found on the Compensation
Summary screen.

15 ADVANCE_TO_REC_PTD

Advances Earned The amount of advance that has been earned in the
current period - this information can be found on the
Compensation Summary Screen.

10 ADVANCE_RECOVERED_PTD

Advances Recovery The amount of advances that will be recovered in this
period - this information can be found in the
Compensation Summary screen.

10 RECOVERY_AMOUNT_PTD

Advances Ending
Balance

Advance Beginning Balance + Advance Current - Earned
In Period + Recovery Amount. This information can be
found on the Compensation Summary screen.

15 (:ADVANCE_TO_REC_ITD -
:ADVANCE_RECOVERED_ITD
+
:RECOVERY_AMOUNT_ITD)

Details <Plan
Element> (In <credit
type> <Incentive
Type> Current

The incentive amount earned by the salesperson during
this period for the stated plan element.

10 COMMISSION_PAYED_PTD

Details <Plan
Element> (In <credit
type> <Incentive
Type> <Interval
Name>

The incentive amount earned by the salesperson for the
<Interval Name> duration, for  the stated plan element.

10 COMMISSION_PAYED_ITD

Details <Plan
Element> (In <credit
type> Amount
Pending Current

The amount of incentive pending for the selected
salesperson during this period with the stated plan
element.

10 COMM_PEND_PTD

Details <Plan
Element> (In <credit
type> Amount
Pending <Interval
Name>

The amount of incentive pending for the selected
salesperson during this <Interval Name> duration,  with
the stated plan element.

10 COMM_PEND_ITD

Details <Plan
Element> (In <credit
type> <Accumulated
Performance
Measure> Current

The selected measure amount earned by the salesperson
during this period for the stated plan element.

10 PERF_ACHIEVED_PTD

Details <Plan
Element> (In <credit
type> <Accumulated

The selected measure amount earned by the salesperson
for the <Interval Name> duration, for  the stated plan
element.

10 PERF_ACHIEVED_ITD
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Column Title Description Value
Length

Column Name/Formula

Performance
Measure> <Interval
Name>
Details <Plan
Element> (In <credit
type> Quota Current

The period quota target for the selected plan element
assigned to the selected salesperson.

10 TARGET_AMOUNT

Details <Plan
Element> (In <credit
type> Quota
<Interval Name>

The <Interval Name> duration quota target for the
selected plan element assigned to the selected
salesperson.

10 ITD_TARGET

Details <Plan
Element> (In <credit
type> Quota
Achievement %
Current

The percentage of quota achieved for the stated
salesperson during this period for the stated plan
element. Measure/Quota * 100.

10 (:PERF_ACHIEVED_PTD/:TAR
GET_AMOUNT)*100)

Details <Plan
Element> (In <credit
type> Quota
Achievement %
<Interval Name>

The percentage of quota achieved for the stated
salesperson for the <Interval Name> duration and for
the stated plan element.

10 ((:PERF_ACHIEVED_ITD/ITD_
TARGET)*100)

Details <Plan
Element> (In <credit
type> Amount to
Reach Quota Current

The amount of outstanding quota required to reach the
selected plan elements quota target set for the current
period and for the selected salesperson. Quota - Measure.

10 (:TARGET_AMOUNT-
:PERF_ACHIEVED_PTD)

Details <Plan
Element> (In <credit
type> Amount to
Reach Quota
<Interval Name>

The amount of outstanding quota required to reach the
selected plan elements <Interval Name> duration quota
target set for the selected salesperson.

10 (:ITD_TARGET-
:PERF_ACHIEVED_ITD

Details <Plan
Element> (In <credit
type> Goal Current

The period goal  target for the selected plan element
assigned to the selected salesperson.

10 PERFORMANCE_GOAL_PTD

Details <Plan
Element> (In <credit
type> Goal <Interval
Name>

The <Interval Name> duration goal target for the
selected plan element assigned to the selected
salesperson.

10 PERFORMANCE_GOAL_ITD

Details <Plan
Element> (In <credit
type> Goal
Achievement %
Current

The percentage of goal achieved for the stated
salesperson during this period for the stated plan
element.

10 ((:PERF_ACHIEVED_PTD/:PE
RFORMANCE_GOAL_PTD)*10
0)

Details <Plan
Element> (In <credit
type> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson for the <Interval Name> duration, for  the
stated plan element.

10 ((:PERF_ACHIEVED_ITD/:PER
FORMANCE_GOAL_ITD)*100)
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Column Title Description Value
Length

Column Name/Formula

<Interval Name>
Details <Plan
Element> (In <credit
type> Amount to
Reach Goal Current

The amount of outstanding goal required to reach the
selected plan elements goal target set for the current
period and for the selected salesperson. Goal - Measure.

10 (:PERFORMANCE_GOAL_PTD
- PERF_ACHIEVED_PTD)

Details <Plan
Element> (In <credit
type> Amount to
Reach Goal <Interval
Name>

The amount of outstanding goal required to reach the
selected plan elements <Interval Name> duration, goal
target set for the selected salesperson.

10 (:PERFORMANCE_GOAL_ITD
-
:PERF_ACHIEVED_ITD)
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Layout/Graphics
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SUMMARY (Current period) Incentive
Amount

Measure
Amount

Quota
Achievement %

Goal Achievement
%

Commission
  <plan element name 1> 300 450,000 75% 100%
  <plan element name 2> 300 300,000 60% 40%
Bonus
  <plan element name 3> 200 300 25% 5%
  <plan element name 4> 100 30 50% 30%
  <plan element name 5> 50 500,000 80% 60%

ADVANCES
Beginning Balance 100
Current 200
Earned 100
Recovery 50
Ending Balance 150

DETAILS
<Plan Element Name 1> (In <credit type>)

Current <Interval Name>
<Incentive Type> Amount 300 350
Amount Pending 100 100
<Accumulated Performance Measure>
Amount

450,000 600,000

Quota 600,000 1,800,000
Quota Achievement % 75% 33%
Amount to Reach Quota 150,000 1,200,000
Goal Amount 450,000 1,350,000
Goal Achievement % 100% 44%
Amount to Reach Goal 0 750,000
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<Plan Element Name 2> (In <credit type>)
Current <Interval Name>

<Incentive Type> Amount 300 700
Amount Pending 200 200
<Accumulated Performance Measure>
Amount

300,000 700,000

Quota 500,000 1,500,000
Quota Achievement % 60% 47%
Amount to Reach Quota 200,000 800,000
Goal 750,000 2,250,000
Goal Achievement % 40% 31%
Amount to Reach Goal 450,000 1,550,000

<Plan Element Name 3> (In <credit type>)
Current <Interval Name>

<Incentive Type> Amount 200 700
Amount Pending 50 50
<Accumulated Performance Measure>
Amount

300 800

Quota 1,200 3,600
Quota Achievement % 25% 22%
Amount to Reach Quota 900 2,800
Goal 6,000 18,000
Goal Achievement % 5% 4%
Amount to Reach Goal 5,700 17,200
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<Plan Element Name 4> (In <credit type>)
Current <Interval Name>

<Incentive Type> Amount 100 190
Amount Pending 100 100
<Accumulated Performance Measure>
Amount

30 100

Quota 60 180
Quota Achievement % 50% 56%
Amount to Reach Quota 30 50
Goal 100 300
Goal Achievement % 30% 16%
Amount to Reach Goal 70 250

<Plan Element Name 5> (In <credit type>)
Current <Interval Name>

<Incentive Type> Amount 50 70
Amount Pending 20 20
<Accumulated Performance Measure>
Amount

500,000 1,200,000

Quota 625,000 1,875,000
Quota Achievement % 80% 64%
Amount to Reach Quota 125,000 675,000
Goal 833,333 2,499,999
Goal Achievement % 60% 48%
Amount to Reach Goal 333,333 1,299,999
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Compensation Details Report (Fiscal View)
This performance report is used primarily by the salesperson and sales manager. It shows plan element details of commission and
bonus, and achievement levels by performance measure against quota and goal. This report shows the current period and interval to
date results as well as a fiscal view. When viewed as the fiscal year, the graph shows only the current period.

This report mirrors the information provided on the Compensation Detail screen and links to the Compensation Summary, the
Compensation Trend Reports, and further detail in the Sales Credit report. The <Plan Element Name> fields link to the Performance
Details report.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using
the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. If not
entered the salesperson number must be entered.
Once a value is selected in the salesperson name
field the salesperson numbers should be
automatically populated also.

The person
who has
logged in.

Y NAME

Salesperson Number LOV - All the salespersons’ numbers. If not
entered the salesperson name must be entered .
Once a value is selected in the salesperson
number field the salesperson name should be
automatically populated also.

The person
who has
logged in.

Y EMPLOYEE_NUMBER

Salesperson Type LOV - List of all the salesperson types available
for this salesperson. Examples are Employee and
Other. This LOV is restricted to the salesperson
types applicable to the salesperson and role
selected.

Employee Y TYPE

Salesperson Role LOV - All roles available for this salesperson,
user should be able to pick ‘All’, which would
represent a summary of all of their roles
together.  This LOV is restricted to the roles
applicable to the salesperson selected.

ALL Y NAME

Credit Type LOV - List of all the credit types available for
this salesperson. This LOV is restricted to the

Y NAME
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appropriate values for the salesperson and role
selected.

Reporting Period LOV - List of all accumulated periods available.
The LOV is restricted to the role and
salesperson.

Y ?

Currency Type Functional or Salesperson currency Default to
the
salesperson
currency.

Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Compensation Plan LOV - List of all the compensation plans
restricted by the information entered in all the
other parameter fields.

Y ?
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Data

Column Descriptions

The following table describes each column to be included in the Compensation Details Report (Fiscal View).

Column Title Description Value
Length

Column Name/Formula

Summary (Current
period) Commission
<Plan Element>
Incentive Amount

The incentive amount of commission earned by the
salesperson during this period for the stated plan
element.

10 ?

Summary (Current
period) Commission
<Plan Element>
Measure Amount

The selected measure amount of commission earned by
the salesperson during this period for the stated plan
element.

10 ?

Summary (Current
period) Commission
<Plan Element>
Quota Achievement
%

The percentage of quota achieved for the stated
salesperson during this period for the stated commission
plan element.

10 ?

Summary (Current
period) Commission
<Plan Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated commission
plan element.

10 ?

Summary (Current
period) Bonus <Plan
Element> Incentive
Amount

The incentive amount of bonus earned by the
salesperson during this period for the stated plan
element.

10 ?

Summary (Current
period) Bonus <Plan
Element> Measure
Amount

The selected measure amount of bonus earned by the
salesperson during this period for the stated plan
element.

10 ?

Summary (Current
period) Bonus <Plan
Element> Quota
Achievement %

The percentage of quota achieved for the stated
salesperson during this period for the stated bonus plan
element.

10 ?

Summary (Current
period) Bonus <Plan
Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated bonus plan
element.

10 ?

Advances Beginning
Balance

The balance in advances that have not yet been earned.
This information can be found on the Compensation
Summary screen..

15 ?
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Column Title Description Value
Length

Column Name/Formula

Advances Current The amount of advances paid in the current period -
This information can be found on the Compensation
Summary screen.

15 ADVANCE_PAID_PTD

Advances Earned The amount of advance that has been earned in the
current period - this information can be found on the
Compensation Summary Screen.

10 ADVANCE_EARNED_PTD

Advances Recovery The amount of advances that will be recovered in this
period - this information can be found in the
Compensation Summary screen.

10 RECOVERY_AMOUNT_PTD

Advances Ending
Balance

Advance Beginning Balance + Advance Current - Earned
In Period + Recovery Amount. This information can be
found on the Compensation Summary screen.

15 ?

Details <Plan
Element> (In <credit
type> <Incentive
Type> <Period>

The incentive amount earned by the salesperson during
this period for the stated plan element.

10 ?

Details <Plan
Element> (In <credit
type> Amount
Pending <Period>

The amount pending for the selected salesperson during
this period with the stated plan element.

10 ?

Details <Plan
Element> (In <credit
type> <Accumulated
Performance
Measure> <Period>

The selected measure amount earned by the salesperson
during this period for the stated plan element.

10 ?

Details <Plan
Element> (In <credit
type> Quota
<Period>

The period quota target for the selected plan element
assigned to the selected salesperson.

10 ?

Details <Plan
Element> (In <credit
type> Quota
Achievement %
<Period>

The percentage of quota achieved for the stated
salesperson during this period for the stated plan
element.

10 ?

Details <Plan
Element> (In <credit
type> Amount to
Reach Quota
<Period>

The amount of outstanding quota required to reach the
selected plan elements quota target set for the period
and for the selected salesperson.

10 ?

Details <Plan
Element> (In <credit
type> Goal <Period>

The period goal  target for the selected plan element
assigned to the selected salesperson.

10 ?

Details <Plan
Element> (In <credit
type> Goal

The percentage of goal achieved for the stated
salesperson during this period for the stated plan
element.

10 ?
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Column Title Description Value
Length

Column Name/Formula

Achievement %
<Period>
Details <Plan
Element> (In <credit
type> Amount to
Reach Goal <Period>

The amount of outstanding goal required to reach the
selected plan elements goal target set for the period and
for the selected salesperson.

10 ?
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Layout/Graphics
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SUMMARY (Current period) Incentive
Amount

Measure
Amount

Quota
Achievement %

Goal Achievement
%

Commission
  <plan element name 1> 300 450,000 75% 100%
  <plan element name 2> 300 300,000 60% 40%
Bonus
  <plan element name 3> 200 300 25% 5%
  <plan element name 4> 100 30 50% 30%
  <plan element name 5> 50 500,000 80% 60%

ADVANCES
Beginning Balance 100
Current 200
Earned 100
Recovery 50
Ending Balance 150

DETAILS
<Plan Element 1>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999
<Incentive Type> Amount 50 300 0 0 0 0 0 0 0 0
Amount Pending 0 100 100 100 100 100 100 100 100 100 100
<Accumulated Performance
Measure> Amount

150,000 450,000 0 0 0 0 0 0 0 0

Quota 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000
Quota Achievement % 25% 75% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 450,000 150,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000 600,000
Goal Amount 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000
Goal Achievement % 33% 100% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 300,000 0 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000 450,000
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<Plan Element 2>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999
<Incentive Type> Amount 400 300 0 0 0 0 0 0 0 0
Amount Pending 0 200 200 200 200 200 200 200 200 200 200
<Accumulated Performance
Measure> Amount

400,000 300,000 0 0 0 0 0 0 0 0

Quota 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000
Quota Achievement % 80% 60% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 100,000 200,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000 500,000
Goal Amount 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000
Goal Achievement % 53% 40% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 350,000 450,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000 750,000

<Plan Element 3>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999
<Incentive Type> Amount 500 200 0 0 0 0 0 0 0 0
Amount Pending 0 50 50 50 50 50 50 50 50 50 50
<Accumulated Performance
Measure> Amount

500 300 0 0 0 0 0 0 0 0

Quota 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200
Quota Achievement % 42% 25% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 700 900 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200 1,200
Goal Amount 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000
Goal Achievement % 8% 5% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 5,500 5,700 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000 6,000
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<Plan Element 4>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999
<Incentive Type> Amount 90 100 0 0 0 0 0 0 0 0
Amount Pending 0 100 100 100 100 100 100 100 100 100 100
<Accumulated Performance
Measure> Amount

70 30 0 0 0 0 0 0 0 0

Quota 60 60 60 60 60 60 60 60 60 60 60
Quota Achievement % 100% 50% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 0 30 60 60 60 60 60 60 60 60 60
Goal Amount 100 100 100 100 100 100 100 100 100 100 100
Goal Achievement % 70% 30% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 30 70 100 100 100 100 100 100 100 100 100

<Plan Element 5>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999
<Incentive Type> Amount 20 50 0 0 0 0 0 0 0 0
Amount Pending 0 20 20 20 20 20 20 20 20 20 20
<Accumulated Performance
Measure> Amount

700,000 500,000 0 0 0 0 0 0 0 0

Quota 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000
Quota Achievement % 100% 80% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 0 125,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000 625,000
Goal Amount 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333
Goal Achievement % 84% 60% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 133,333 333,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333 833,333
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Performance Reports

Compensation Summary Report
This report mirrors the information provided on the Compensation Summary screen. The primary users of this performance report
are sales representatives and sales managers. Compensation analysts use this report to find a salesperson’s earnings and sales
credits.

You can export this information by using the ‘export to excel’ function.

Administrators can enter user-defined messages that will appear at the bottom of each report to be distributed to the sales force.
Note that the graph figures used in this example are hypothetical data and do not match the figures in the report layout example, nor
do the figures total up correctly. Instead, the figures are used to highlight how values should be displayed.

The current period commission and current period bonus figures link to the Compensation Details report. The current period gross
pay <period range> fields link to the Payrun Detail Report. The commission pending and bonus pending fields link to the Pending
Transactions Report.
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Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. If not
entered the salesperson number must be entered.
Once a value is selected in the salesperson name
field the salesperson number should be
automatically populated also.

The person
who has
logged in.

Y NAME

Salesperson Role LOV - All roles available for this salesperson,
user should be able to pick “ALL”, which would
represent a summary of all of their roles
together. This LOV is restricted to the roles
applicable to the salesperson selected.

ALL Y NAME

Reporting Period LOV - List of all Accumulated periods available.
The LOV is restricted to the role and
salesperson.

Y PERIOD_NAME

Currency Type Functional or Rep Currency Default to
the
Salesperson
Currency.

Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Credit Type LOV - List of all the credit types available for
this salesperson. The LOV is restricted to the
appropriate values for the salesperson and sales
role selected.

Y NAME
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Data

Column Descriptions

The following table describes each column to be included in the Compensation Summary Report.

Column Title Description Value
Length

Column Name/Formula

Commission The amount of commission earned by the salesperson
during this period | quarter-to-date | year-to-date - This
information can be found on the Compensation
Summary screen.

10 For  period
COMMISSION_EARNED_PTD

For quarter-to-date
COMMISSION_EARNED_QTD

For  year-to-date
COMMISSION_EARNED_YTD

Bonus The amount of bonus earned by the salesperson during
this period | quarter-to-date | year-to-date - This
information can be found on the compensation
Summary screen.

10 For period
BONUS_EARNED_PTD

For quarter-to-date
BONUS_EARNED_QTD

For year-to-date
BONUS_EARNED_YTD

Other Manual Bonus - This information can be found on the
Compensation Summary screen.

10 For period
OTHER_EARNED_PTD

For quarter-to-date
OTHER_EARNED_QTD

For year-to-date
OTHER_EARNED_YTD

Advance Commission The amount of commission being advanced to the
salesperson in  the current period - this information can
be found on the Compensation Summary Screen.

10 For period
ADVANCE_COMMISSION_PT
D

For quarter-to-date
ADVANCE_COMMISSION_QT
D

For year-to-date
ADVANCE_COMMISSION_YT
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Column Title Description Value
Length

Column Name/Formula

D

Total Compensation The total amount of Commission Earned, Bonus Earned,
Other Earned and Advance Commissions - This
information can be found on the Compensation
Summary Screen.

10 For period
COMMISSION_EARNED_PTD
+ BONUS_EARNED_PTD +
OTHER_EARNED_PTD +
ADVANCE_COMMISSION_PT
D

For quarter-to-date
COMMISSION_EARNED_QTD
+ BONUS_EARNED_QTD +
OTHER_EARNED_QTD +
ADVANCE_COMMISSION_QT
D

For year-to-date
COMMISSION_EARNED_YTD
+ BONUS_EARNED_YTD +
OTHER_EARNED_YTD +
ADVANCE_COMMISSION_YT
D

Gross Payment List all payment for this accumulation period - This
information can be found on the Compensation
Summary screen.

10 GROSS_PAY

Total Payments Summarize all payruns - this information can be found
on the Compensation Summary screen.

15 Total of “Gross Payment”
(GROSS_PAY)

Advance - Begin The balance in advances that have not yet been earned -
This information can be found on the Compensation
Summary screen.

10 (ADVANCE_PAID_YTD -
ADVANCE_EARNED_YTD +
RECOVERY_AMOUNT_YTD) -
(ADVANCE_PAID_PTD -
ADVANCE_EARNED_PTD +
RECOVERY_AMOUNT_PTD)

Advance - Current The amount of advances paid in the current period -
This information can be found on the Compensation
Summary screen.

15 ADVANCE_PAID_PTD

Earned in Current
Period

The amount of advances that has been earned in the
current period - this information can be found on the
Compensation Summary screen.

10 ADVANCE_EARNED_PTD

Recovery Amount The amount of advances that will be recovered in this
period - this information can be found on the
Compensation Summary screen.

10 RECOVERY_AMOUNT_PTD

Advances - End
Balance

Advances Beginning Balance + Advances Current -
Earned in Period + Recovery Amount - This

15 ADVANCE_PAID_YTD -
ADVANCE_EARNED_YTD +
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Column Title Description Value
Length

Column Name/Formula

information can be found on the Compensation
Summary screen.

RECOVERY_AMOUNT_YTD

Commission Pending The amount of commission this is pending payment
because it did not pass validation - this information can
be found on the Compensation Summary screen.

10 COMMISSION_PENDING_PTD

Bonus Pending The amount of bonus that is pending because it did not
pass validation - this information can be found on the
Compensation Summary screen.

10 BONUS_PENDING_PTD
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Layout/Graphics
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Curren
t
Period

QTD YTD Advances

Commission 200 200 200 Beginning Balance 1,000
Bonus 100 100 100 Paid in Current

Period
100

Other 50 50 50 Earned in Current
Period

300

Advance Commission 130 130 130 Amount Recovered (500)
Total Compensation 480 480 480 Ending Balance 300

Gross Pay 15-Oct-1997 300 Pending
Gross Pay 28-Oct-1997 100 Commission Pending 100
Total Payments 400 Bonus Pending 50
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Hierarchy Report
This report shows hierarchy structure for all “dimension” hierarchies such as revenue classes, customers, and products. Users can enter
messages that will appear at the bottom of a report.

The results of a query show parent rules/children rules of the search criteria (rule name) all the way to the top/bottom of the hierarchy
(direct path). The search criteria phrase is displayed in a different color in the report results so that it stands out from the other rule
names that are returned as a result of the query.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Dimension Name LOV-  All the dimensions defined
by the user.

Y NAME

Hierarchy Name LOV- All the hierarchies defined
by the user . This list is dependent
on the Dimension Name
parameter.

Y NAME

Node Name LOV - All the available nodes for
any given hierarchy and the extra
choice ‘ALL’. This list is
dependent on the Dimension
Name and Hierarchy Name
parameters.

ALL Y NAME

Effective Date No LOV - The Calendar feature
should be used.

Current Date Y CALANDER WIDGET
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Data

Column Descriptions

The following table describes each column to be included in the Hierarchy Report.

Column Title Description Value
Length

Column Name/Formula

Hierarchy Node
Name

Display the name of the item which is in the
hierarchy, for example, salesperson, revenue
class. Also display the value of the primary
key for the dimension defined if different to
the name, for example, Salesrep_id in the
Salesrep hierarchy. This field is indented to
represent different levels in the hierarchy.
Show up to four levels at any one time.

40 NAME
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Layout/Graphics

Example One:

Hierarchy Node
Name
All Hardware

All Computers
Dell
Compaq
HP

Monitors
Drive and Cards
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Example Two:

Hierarchy Node
Name
All Hardware

All Computers
Dell
Compaq
HP
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Payee Report
This report lists sales payees and the amounts they are being paid. The commission and bonus fields link to the Compensation
Summary report. The gross pay fields link to the Payrun Detail report.

You can enter messages that will appear at the bottom of a report. You can export information from this report by using the ‘export to
excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Payee Name LOV - All the payee’ names and
the extra choice ‘All’. If not
entered the payee number must be
entered. Once a value is selected in
the payee name field the payee
number field should be
automatically populated also.

All Y ?

Payee Number LOV - All the payee’ numbers and
the extra choice ‘All’. If not
entered the payee name must be
entered. Once a value is selected in
the payee number field the payee
name field should be automatically
populated also.

All Y ?

Payee Type LOV -All payee types available
for payee’s and the extra choice
‘All’. If payee information has
been entered, restrict this LOV
further using the payee values
entered.

All Y ?

Sales Role LOV - All roles available for
payee’s and the extra choice ‘All’.
If payee information has been
entered, restrict this LOV further
using the payee values entered.

All Y ?

Payrun Name LOV - All payrun names and the
extra choice ‘ALL’.

All Y ?

Pay Period LOV.- All pay periods and the All Y ?
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extra choice ‘All’.
Pay Date LOV - All pay dates and the extra

choice ‘All’.
All Y ?

Sort By LOV - All the fields used in this
report stated in the data section.

N New functionality

Then By LOV - All the fields used in this
report except the one stated in
the ‘sort by’ parameter. If no
value is entered in the ‘sort by’
column then this parameter should
be disabled.

N New functionality

Finally By LOV - All the fields used in this
report except the values entered
in the ‘sort by’ and ‘finally by’
parameter fields. If no value is
entered in the ‘then by’ column
then this parameter should be
disabled.

N New functionality
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Data

Column Descriptions

The following table describes each column to be included in the Payee Report.

Column Title Description Value
Length

Column Name/Formula

Payee Name The payee’s name receiving payment ? ?
Payee Number The payee’s number receiving payment ? ?
Payee Type The payee’s type.
Sales Role The role assigned to the payee receiving

payment.
? ?

Cost Center The payee’s cost center(s) ? ?
Credit Type The credit type for the compensation

calculation.
? ?

Commission Commission payee earned for this period. ? ?
Bonus Bonus payee earned for this period ? ?
Gross Pay The payee’s gross pay  figure ? ?
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Layout/Graphics

Payee Name Payee
Number

Payee Type Sales Role Cost
Cente
r

Credit
Type

Commissi
on

Bonus Gross Pay

Bob Wiley 11 Employee Full Time
Agent

D67 Dollar 58,065.00 58,065.00 58,065.00

Barry Lewis 44 Employee Full Time
Agent

D67 Dollar 4,999.64 4,999.64 4,999.64

Delores Smith-
Jones

45 Employee Full Time
Agent

D67 Dollar 42,419.35 42,419.35 42,419.35

Elaine Manley 46 Other Contractor D67 Dollar 152,887.22 152,887.2
2

152,887.22

Howard Sprague 47 Other Contractor D67 Dollar 54,077.25 0.00 54,077.25
Jerrold Feinberg 48 Other Contractor D67 Dollar 30,058.27 30,058.27 30,058.27
Lisa Douglas 49 Other Contractor D67 Dollar 5,793.10 5,793.10 5,793.10
Pat Murphy 50 Other Contractor D67 Dollar 28,451.48 28,451.48 28,451.48

Grand Total 376,751.31 322,674.0
6

376,751.31
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Compensation Trend Report
This report summarizes a salesperson’s compensation earnings. It lists earnings by category, including advances, minimums and
maximums, and amounts paid. It shows every period side-by-side for comparison and pulls information from the same database that
supplies the Compensation Summary screen and report. The information is valuable mainly to the sales representative, sales manager,
and compensation analyst. The total payments figures link to the Payrun Detail Report.
You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using
the ‘export to excel function’.

You cannot display a period in the future for which a commission has not already been earned.
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Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV- All the salespersons’ names and
their employee numbers. If not entered a
salesperson number must be entered. Once
a value is selected in the salesperson name
field the salesperson number should be
automatically populated also.

The person
that logged
in.

Y NAME

Salesperson Number LOV - All the salespersons’ numbers. If
not entered the salesperson name must be
entered. Once a value is selected in the
salesperson number field the salesperson
name should be automatically populated
also.

The person
that logged
in.

Y EMPLOYEE_NUMBER

Salesperson Type LOV - List of all the salesperson  types
available for this salesperson. Examples
are employee and other. This LOV is
restricted to the salesperson types
applicable to the salesperson and sales role
selected.

Employee Y TYPE

Sales Role LOV - All roles available for this
salesperson. This LOV is restricted to the
salesperson selected.

Y NAME

Credit Type LOV - List of all the credit types available
for this salesperson. The LOV is restricted
to the role, type and salesperson.

Y NAME

Currency Type Functional or Salesperson currency Default to
the
salesperson
currency

Y SELECT MEANING
FROM CN_LOOKUPS
WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Start Period LOV - List of all available periods. This
list is restricted to the reporting periods
available for the selected salesperson with
the selected role and resource type.

Y PERIOD_NAME

End Period LOV - List of all available periods. This
list is restricted to a maximum of 12
available periods after the period selected
in the start period parameter. A can’t
enter an end date period if a start period
has not been entered. This list is also
restricted to the reporting periods
available for the selected salesperson with
the selected role and resource type.

Should
default to
twelve
months
from the
start period
or the latest
available
period

Y PERIOD_NAME
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stated in the
LOV.
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Data

Column Descriptions

The following table describes each column to be included in the Compensation Trend Report.

Column Title Description Value
Length

Column Name/Formula

Commission The amount of commission
earned by the salesperson during
this selected stated period

10 COMMISSION_EARNED_PTD

Bonus The amount of bonus earned by
the salesperson during the
selected stated period

10 BONUS_EARNED_PTD

Other The manual bonus amount
earned by the salesperson during
the selected stated period.

10 OTHER_EARNED_PTD

Advance Commission The amount of commission
being advanced to the
salesperson in the selected stated
period.

10 ADVANCE_COMMISSION_PTD

Total Compensation The total amount of commission
earned, bonus earned, other
earned and advance commissions
- This information can be found
on the Compensation Summary
Screen for each selected stated
period.

10 COMMISSION_EARNED_PTD +
BONUS_EARNED_PTD +
OTHER_EARNED_YTD +
ADVANCE_EARNED_YTD

Total Payments Summarise all payruns over the
selected stated periods - This
information can be found on the
compensation summary screen.

10 ?
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Jun-98 Jul-98 Aug-98 Sep-98 Oct-98 Nov-98 Dec-98 Jan-99 Feb-99 Mar-99 Apr-99 May-99
Commission 700 999 350 500 600 400 475 500 600 600 600 300
Bonus 100 75 25 100 75 60 50 50 50 75 0 75
Other 50 0 25 50 50 0 50 50 0 50 25 50
Advance Commission 130 130 130 130 130 130 130 130 130 130 130 130
Total Compensation 980 1,204 530 780 855 590 705 730 780 855 755 555

Total Payments 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000

Payrun Listing Report
This report displays the details for salespeople who were paid for a specified payrun date or payrun name. The gross pay figures
link to the payrun detail report.

If you select ‘All’ in the payrun name parameter and in the pay group parameter, more than one payrun/pay group may be returned.
In this instant the layout body as shown below will be replicated for each unique payrun.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by
using the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Payrun Name LOV - All the payrun names with
the extra option ‘All’.

All Y NAME



OSC Summary Reports
SCReprts.doc  (v. 1.0) Oracle/Client Confidential - For internal use only

3

Pay Group LOV - All the pay groups with the
extra option ‘All’ If a payrun
name is selected then this lov
should be restricted based on that
value.

All Y NAME

Pay Period LOV - All the pay periods. This
parameter is restricted to the
applicable pay periods for the
selected payrun name (If
specified) and pay group (If
specified).

Y PERIOD_NAME

Pay Date NO LOV - The calendar feature
should be used.

N CALANDER WIDGET

Credit Type LOV - All the credit types. This
parameter is restricted to the
applicable credit types for the
selected payrun name (If
specified), pay group (If
specified), pay period and pay
date.

Y NAME
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Data

Column Descriptions

The following table describes each column to be included in the Payrun Listing Report.

Column Title Description Value
Length

Column
Name/Formula

Payrun Name The payrun name that you have selected, or
the payrun name relevant to the pay group
selected.

20 NAME

Salesperson Name The names of salespeople who are part of
selected payrun(s).

30 NAME

Salesperson Number The salesperson numbers for salespeople who
are part of selected payrun(s).

15 EMPLOYEE_NUMBER

Salesperson Type The resource types for the salespeople in the
selected payrun(s).

20 TYPE

Sales Role The roles for the salespeople in the selected
payrun(s).

20 NAME

Charge-To Cost
Center

The charge to cost centers for the salespeople
in the selected payrun(s).

10 COST_CENTER_ID

Gross Pay<In Credit
Type>

Gross Pay salespeople earn for this period.
Value obtained from the Salesperson
Worksheet.

25 COMM_PAID +
REG_BONUS_PAID +
BONUS_PAID +
PAYEE_COMM_PAID +
PAYEE_BONUS_PAID
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Layout/Graphics

Payrun
Name:

BJan-
96

Salesperson
Name

Salesperson
Number

Salesperson
Type

Sales Role Charge To
Cost Center

Gross Pay
<In
Dollar>

Bob Wiley 11 Employee Full Time Agent 1232 58,065.51
Barry Lewis 44 Employee Full Time Agent 1232 4,999.64
Delores Smith-
Jones

45 Employee Full Time Agent 1232 42,419.35

Elaine Manley 46 Others Contractor Agent 1232 152,887.2
2

Howard Sprague 47 Others Contractor Agent 1232 54,077.25
Jerrold Feinberg 48 Others Contractor Agent 1232 30,058.27
Lisa Douglas 49 Others Contractor Agent 1232 5,793.10
Pat Murphy 50 Others Contractor Agent 1232 28,451.48

Grand Total 376,751.3
1
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Payrun Detail Report
This report displays the payrun details for an individual salesperson for a payrun, pay period, and pay date. It also shows amounts
in a salesperson’s required credit type.

If the selected credit type is the same as the functional credit type, those columns returned in the report will be identical. The amount
to pay (functional and salesperson) figures link to ‘Other Details’ in the lower section of the report.

You can enter messages that will appear at the bottom of a report. You can export information from this report by using the ‘export to
excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. Once
a value is selected in the salesperson name
field the salesperson number should be
automatically populated also.

Y NAME

Salesperson Number LOV - All the salespersons’ numbers.
Once a value is selected in the salesperson
number field the salesperson name should
be automatically populated also.

Y EMPLOYEE_NUMBER

Salesperson Type LOV - List of all the salesperson types
available for this salesperson. Examples
are Employee and Other. This LOV is
restricted to the salesperson types
applicable to the salesperson and role
selected.

Employee Y TYPE

Sales Role LOV - All roles available for this
salesperson. This LOV is restricted to the
roles applicable to the salesperson
selected.

Y NAME

Payrun Name LOV - All the payrun names. This
parameter is restricted to the applicable
payrun names for the salesperson and the
role, type entered.

Y NAME

Pay Period LOV - All the pay periods. This
parameter is restricted to the applicable
pay periods for the salesperson, role and
payrun name entered.

Y ? - Not sure where the
PAY_PERIOD_ID is
linked to display the
period in the correct
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format.
Pay Date LOV - All the pay dates. This parameter

is restricted to the applicable pay dates for
the salesperson, role, payrun name and
pay period entered.

Y PAY_DATE

Credit Type LOV - List all the credit types. This
parameter is restricted to the applicable
credit types for the salesperson, role,
payrun name, pay period and pay date
entered.

Default to
the selected
salespersons
‘From’
Credit Type

Y NAME

Returned Fund
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Data

Column Descriptions

The following table describes each column to be included in the Payrun Detail Report.

Column Title Description Value
Length

Column
Name/Formula

Commission Beginning Balance The beginning commission balance
amount for the selected salesperson.

20 COMM_DUE_BB

Commission Amount Due The commission amount due for the
selected salesperson.

20 COMM_PTD

Commission Recoverable Amount The recoverable commission amount for
the selected salesperson.

20 DRAW_PAID

Commission Non-Recoverable
Amount

The non-recoverable commission
amount for the selected salesperson.

20 COMM_NREC

Commission Amount To Recover The commission amount to recover for
the selected salesperson.

20 COMM_DRAW

Commission Amount To Pay In
<Functional Credit Type>

The commission amount to pay for the
selected salesperson.

20 COMM_PAID

Commission Amount To Pay In
<Salesperson Credit Type>

The commission amount to pay for the
selected salesperson in the appropriate
credit type.

20 ?

Comments/Reasoning The reason/comments assigned if the
commission amount figure has been
amended or requires some means of
justification.

35 REASON

Bonus Beginning Balance The beginning bonus balance to pay for
the selected salesperson.

20 REG_BONUS_DUE_BB

Bonus Amount Due The bonus amount due for the selected
salesperson.

20 REG_BONUS_PTD

Bonus Recoverable Amount The recoverable bonus amount for the
selected salesperson.

20 REG_BONUS_REC

Bonus Amount To Recover The bonus amount to recover for the
selected salesperson.

20 REG_BONUS_TO_REC

Bonus Amount To Pay In
<Functional Credit Type>

The bonus amount to pay for the
selected salesperson.

20 REG_BONUS_PAID

Bonus Amount To Pay In
<Salesperson Credit Type>

The bonus amount to pay for the
selected salesperson in the appropriate
credit type.

20 ?

Comments/Reasoning The reason/comments assigned if the
bonus amount figure has been amended or
requires some means of justification.

35 BONUS_REASON

Other Beginning Balance The beginning other balance to pay for
the selected salesperson.

20 BONUS_DUE_BB
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Column Title Description Value
Length

Column
Name/Formula

Other Amount Due The other amount due for the selected
salesperson.

20 BONUS_PTD

Other Amount To Pay In
<Functional Credit Type>

The other amount to pay for the selected
salesperson.

20 BONUS_PAID

Other Amount To Pay In
<Salesperson Credit Type>

The other amount to pay for the selected
salesperson in the appropriate credit
type.

20 ?

Subtotal Beginning Balance The subtotal of  the beginning
commission, bonus and other balances for
the selected salesperson.

20 COMM_DUE_BB +
REG_BONUS_DUE_BB +
BONUS_DUE_BB

Subtotal Amount Due The subtotal amount due (Commission,
bonus and other) for the selected
salesperson.

20 COMM_PTD +
REG_BONUS_PTD +
BONUS_PTD

Subtotal Recoverable Amount The subtotal recoverable amount
(Commission, bonus and other) for the
selected salesperson.

20 DRAW_PAID +
REG_BONUS_REC

Subtotal Non-Recoverable Amount The subtotal non-recoverable amount
(Commission, bonus and other) for the
selected salesperson.

20 COMM_NREC

Subtotal Amount To Recover The subtotal amount to recover
(Commission, bonus and other) for the
selected salesperson.

20 COMM_DRAW +
REG_BONUS_TO_REC

Subtotal Amount To Pay In
<Functional Credit Type>

The subtotal amount to pay
(Commission, bonus and other) for the
selected salesperson.

20 COMM_PAID +
REG_BONUS_PAID +
BONUS_PAID

Subtotal Amount To Pay In
<Salesperson Credit Type>

The subtotal amount to pay
(Commission, bonus and other) for the
selected salesperson in the appropriate
credit type.

20 ?

Payee Commission Beginning
Balance

The beginning payee commission balance
to pay for the selected salesperson(s).

20 PAYEE_COMM_DUE_BB

Payee Commission Amount Due The payee commission amount due for
the selected salesperson(s).

20 PAYEE_COMM_PTD

Payee Commission Amount To
Pay In <Functional Credit Type>

The payee commission amount to pay
for the selected salesperson(s).

20 PAYEE_COMM_PAID

Payee Commission Amount To
Pay In <Salesperson Credit Type>

The payee commission amount to pay
for the selected salesperson(s).

20 ?

Payee Bonus Beginning Balance The beginning payee bonus balance to
pay for the selected salesperson(s).

20 PAYEE_BONUS_DUE_BB

Payee Bonus Amount Due The payee bonus amount due for the
selected salesperson(s).

20 PAYEE_BONUS_PTD

Payee Bonus Amount To Pay In
<Functional Credit Type>

The payee bonus amount to pay for the
selected salesperson(s).

20 PAYEE_BONUS_PAID

Payee Bonus Amount To Pay In
<Salesperson Credit Type>

The payee bonus amount to pay for the
selected salesperson(s) in the appropriate

20 ?
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Column Title Description Value
Length

Column
Name/Formula

credit type.
Grand Total Beginning Balance The grand total of  the beginning

commission, bonus, other, payee
commission and payee bonus balances for
the selected salesperson.

25 COMM_DUE_BB +
REG_BONUS_DUE_BB +
BONUS_DUE_BB +
PAYEE_COMM_DUE_BB
+
PAYEE_BONUS_DUE_BB

Grand Total Amount Due The grand total amount due
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson.

25 COMM_PTD +
REG_BONUS_PTD +
BONUS_PTD +
PAYEE_COMM_PTD +
PAYEE_BONUS_PTD

Grand Total Recoverable Amount The grand total recoverable amount
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson.

25 DRAW_PAID +
REG_BONUS_REC

Grand Total Non-Recoverable
Amount

The grand total non-recoverable amount
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson.

25 COMM_NREC

Grand Total Amount to Recover The grand total amount to recover
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson.

25 COMM_DRAW +
REG_BONUS_TO_REC

Grand Total Amount To Pay In
<Functional Credit Type>

The grand total amount to pay
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson.

25 COMM_PAID +
REG_BONUS_PAID +
BONUS_PAID +
PAYEE_COMM_PAID +
PAYEE_BONUS_PAID

Grand Total Amount To Pay In
<Salesperson Credit Type>

The grand total amount to pay
(Commission, bonus, other, payee
commission and payee bonus) for the
selected salesperson in the appropriate
credit type.

25 ?

Other Payment Details -
Compensation Plan

The compensation plan that the selected
salespersons other payment amount
should be added to.

30 NAME

Other Payment Details - Plan
Element

The compensation plans plan element
that the selected salespersons other
payment amount should be added to.

30 NAME

Other Payment Details - Amount
To Pay In <Functional Credit
Type>

The other payment amount for the
selected salespersons  compensation
plans plan element.

15 AMOUNT

Other Payment Details - Amount
To Pay In <Salesperson Credit

The other payment amount for the
selected salespersons compensation plans

15 ?
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Column Title Description Value
Length

Column
Name/Formula

Type> plan element in the appropriate credit
type.

Other Payment Details - Total
Amount To Pay In <Functional
Credit Type>

The total of  the other payment amounts
for all the compensation plans, plan
elements for the selected salesperson.

20 Total of the AMOUNT
column.

Other Payment Details - Total
Amount To Pay In <Salesperson
Credit Type>

The total of the other payment amounts
for all the compensation plans, plan
elements for  the selected salesperson in
the appropriate credit type.

20 ?
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Beginnin
g

Balance

Amount
Due

Recovera
ble

Payment

Non-
Recovera

ble
Payment

Amount
To

Recove
r

Amount
To Pay

In
<Dollar

>

Amount To
Pay In

<Dollar>

Pay Adjustment Comments

Commission 1,000.00 500.00 1,500.00 0.00 0.00 3,000.0
0

3,000.00

Bonus 793.10 0.00 0.00 0.00 793.10 793.10
Other 500.00 0.00 2,000.0

0
2,000.00

Subtotal 2,293.10 500.00 1,500.00 0.00 0.00 5,793.1
0

5,793.10

Payee
Commission

0.00 0.00 0.00 0.00

Payee Bonus 0.00 0.00 0.00 0.00
Grand Total 6,500.10 3,000.00 1,500.00 0.00 0.00 5,793.1

0
5,793.10

Other Payment
Details

Compen
sation
Plan

Plan
Element

Amount
To Pay In
<Dollar>

Amount To
Pay In

<Dollar>
Comp Plan
1

Quota 1 700.00 700.00

Comp Plan
1

Quota 2 800.00 800.00

Comp Plan
1

Quota 3 250.00 250.00

Comp Plan
1

Quota 4 250.00 250.00

Total 2,000.00 2,000.00
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Pending Payment Report
This standard concurrent manager report lists all the people with payment pending and the amounts. The commission pending and
bonus pending figures link to the Pending Transaction Report.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by
using the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names and the extra
choice ‘All’. If not entered the salesperson number
must be entered. Once a value is selected in the
salesperson name field the salesperson number
should be automatically populated also.

All Y NAME

Sales Role LOV - All roles available for this salesperson, user
should be able to pick “All”, which would represent
a summary of all of their roles together. This LOV
is restricted to the roles applicable to the
salesperson and type selected.

All Y NAME

Credit Type LOV - List of all the credit types available for this
salesperson if selected  with the extra choice ‘All’.
This LOV is restricted to the appropriate values for
the salesperson and sales role selected.

All Y NAME

Start Period LOV - from system. This LOV should be restricted
to the periods available for the salesperson
name/number entered.

Current
Period

Y PERIOD_NAME

End Period LOV -from system..  If a start period has been
entered the end period LOV should not include
periods earlier than that period. This LOV should
also be restricted to the periods available for the
salesperson name/number entered.

Current
Period

Y PERIOD_NAME
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Data

Column Descriptions

The following table describes each column to be included in the Pending Payment Report.

Column Title Description Value
Length

Column Name/Formula

Pay Period The required period, LOV from the
system.

15 PERIOD_NAME

Salesperson Name The salesperson name, LOV from
the system.

40 NAME

Salesperson Number The salesperson number, LOV from
the system

10 EMPLOYEE_NUMBER

Salesperson Type The salesperson type, LOV from
the system

20 TYPE

Sales Role The salespersons role(s), LOV from
the system.

40 NAME

Credit Type The credit type, LOV from the
system.

20 NAME

Commission Pending Commission Pending for a
salespersons earnings this period.
Value obtained from the
Salesperson Worksheet.

12 COMM_PEND_PTD

Bonus Pending Bonus Pending for a salesperson
earnings this period. Value obtained
from the Salesperson Worksheet.

12 COMM_PEND_PTD
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Pay
Period

Salesperson Name Salespers
on
Number

Salesperso
n Type

Sales Role Credit Type Commissio
n Pending

Bonus
Pending

Jun-99 Bob Whiley 11 Employee Full Time
Agent

USD 12,012 0

Jun-99 Barry Lewis 44 Employee Full Time
Agent

Air Miles 10,123 0

Jun-99 Elaine Manley 46 Employee Contractor USD 23,000 0
Jun-99 Howard Sprague 47 Others Contractor Air Miles 12,236 0
Jun-99 Lisa Douglas 49 Others Contractor Long Distance

Min
8,223 0

Jun-99 Pat Murphy 50 Others Contractor USD 12,000 0
Jun-99 Delores Jones 45 Others Full Time

Agent
USD 22,000 0

Jun-99 Jerrold Feinberg 48 Others Contractor USD 21,843 0



OSC Summary Reports
SCReprts.doc  (v. 1.0) Oracle/Client Confidential - For internal use only

2

Known Where Conditions

Where the COMM_PEND_PTD field in the CN_SRP_PERIOD_QUOTAS view is greater than 0. The SALESREP_ID field
in the CN_SALESREPS view is equal to the SALESREP_ID field in the CN_PERIOD_QUOTAS view. The PERIOD_ID
field in the CN_ACC_PERIOD_STATUSES_V view is equal to the PERIOD_ID field in the CN_PERIOD_QUOTAS view.
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Pending Transaction Report
This standard concurrent manager report lists all transactions that have a pending status and a history of the pending status.

Enter your information for the basic parameters. The example below shows the requirements for basic parameter setup.

You can enter messages that will appear at the bottom of a report. You can export the information from some fields of this report by
using the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Credited Salesperson
Name

LOV - All the sales persons’ names and the extra choice
‘ALL’. Once a value is selected in the salesperson name
field the salesperson number should be automatically
populated also.

ALL Y NAME

Credited Salesperson
Number

LOV - All the salespersons’ numbers  and the extra choice
‘ALL’. Once a value is selected in the salesperson number
field the salesperson name should be automatically
populated also.

ALL Y EMPLOYEE_NUMBER

Credited Salesperson
Type

LOV - List of all the salesperson types available for the
salesperson (If selected) and the extra choice ‘All’.
Examples are Employee and Other. This LOV is
restricted to the salesperson types applicable to the
salesperson and role selected.

All Y TYPE

Start Date No LOV - The calendar  feature should be used. N CALANDER WIDGET
End Date No LOV - The calendar feature should be used. This

parameter can hold a date no earlier than that entered in
the start date parameter field. You still need to be able to
enter a date in this parameter if the start date parameter
is null.

N CALANDER WIDGET

Invoice Number LOV - All the invoice numbers and the extra choice
‘ALL’. This LOV should be restricted if an individual
salesperson is chosen to only those invoices applicable to
that salesperson. If the process date parameters are used
this parameters LOV should be restricted further to only
the applicable invoice numbers. If the order number
parameter has been entered this LOV should be restricted
further to valid corresponding invoice numbers.

ALL Y INVOICE_NUMBER

Order Number LOV - All the order numbers and the extra choice ‘ALL’.
This LOV should be restricted if an individual  salesperson
is chosen to only those orders applicable to that
salesperson. If the process date parameters are used this

ALL Y ORDER_NUMBER
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Data

Column Descriptions

The following table describes each column to be included in the Pending Transaction Report.

Column Title Description Value
Length

Column Name/Formula

Processed Date The Processed Date 9 PROCESSED_DATE
Pay Period The period the salesperson was paid

in.
8 PERIOD_NAME

Salesperson Name The salesperson name, LOV from
the system.

30 NAME

Salesperson Number The salesperson number, LOV from
the system

10 EMPLOYEE_NUMBER

Salesperson Type The salesperson type, LOV from the
system.

15 TYPE

Sales Role The salespersons role(s), LOV from
the system.

30 NAME

Credit Type The transactions credit type, from
the salesperson worksheet.

20 NAME

Invoice Number The invoice number, from the
salesperson worksheet

12 INVOICE_NUMBER

Invoice Date The invoice date, from the
salesperson worksheet

9 INVOICE_DATE

Order Number The order number, from the
salesperson worksheet

12 ORDER_NUMBER

Order Date The order date, from the salesperson
worksheet

9 BOOKED_DATE

Plan Element The plan element, from the
salesperson worksheet

30 NAME

Revenue Class The revenue class, from the
salesperson worksheet

30 NAME

Quantity The quantity, from the salesperson
worksheet

8 QUANTITY

Transaction Amount The transaction amount, from the
salesperson worksheet

12 TRANSACTION_AMOUNT

Commission Amount The commission amount, from the
salesperson worksheet.

12 COMMISSION_AMOUNT

Days Pending The total number of days pending.
Current date minus the processed
date.

5 CURRENT_DATE -
PROCESSED_DATE
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Processe
d Date

Pay Period Salesperson Name Salesperso
n Number

Salesperso
n Type

Sales Role Credit Type Invoice
Number

Invoice
Date

Order
Numbe
r

Order
Date

Plan
Element

Revenu
e Class

Quantit
y

02-Nov-99 Nov-99 Pat Murphy 50 Employee Contractor USD 6557 21-Oct-99 7655 21-Oct-99 Consulting Cons 1 1
03-Nov-99 Nov-99 Jerrold Feinberg 48 Employee Contractor Air Miles 8678 28-Oct-99 8536 28-Oct-99 Consulting Cons 2 1
08-Nov-99 Nov-99 Delores Jones 45 Employee Contractor USD 6743 02-Nov-99 3765 02-Nov-99 Consulting Cons 1 1
09-Nov-99 Nov-99 Bob Wiley 11 Others Full Time Agent Air Miles 1232 04-Nov -99 3453 04-Nov -99 Consulting Cons 3 1
11-Nov-99 Nov-99 Lisa Douglas 49 Others Contractor Long Distance Min 7545 05-Nov-99 6587 05-Nov-99 Consulting Cons 3 1
13-Nov-99 Nov-99 Howard Sprague 47 Others Contractor USD 4231 10-Nov-99 3456 10-Nov-99 Consulting Cons 1 1
14-Nov-99 Nov-99 Elaine Manley 46 Others Contractor USD 4324 11-Nov-99 4532 11-Nov-99 Consulting Cons 3 2
18-Nov-99 Nov-99 Barry Lewis 44 Others Full Time Agent USD 2143 15-Nov-99 3454 15-Nov-99 Consulting Cons 2 2
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Known Where Conditions

Where the PENDING_STATUS field in the CN_COMMISSION_LINES view is equal to ‘Y’. The SALESREP_ID field in the
CN_COMMISSION_LINES view is equal to the SALESREP_ID in the CN_SALESREPS view.
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Performance Details Report
This report shows details of the Compensation Summary Report and is used primarily by the salesperson and sales manager. It indicates user-
defined measures of achievement within revenue class. Users can see both quota and goal achievement.

This report can be accessed through the Compensation Summary and Compensation Trend reports and links further to the Sales Credits report.
The report can be run to show current period and interval to date results.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using the
‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. If not
entered the salesperson number must be entered.
Once a value is selected in the salesperson name
field the salesperson numbers should be
automatically populated also.

The person
who has
logged in.

Y NAME

Salesperson Role LOV - All roles available for this salesperson,
user should be able to pick ‘All’, which would
represent a summary of all of their roles
together. This LOV is restricted to the roles
applicable to the salesperson selected.

All Y NAME

Credit Type LOV - List of all the credit types available for
this salesperson. This LOV is restricted to the
appropriate values for the salesperson and role
selected.

Y NAME

Reporting Period LOV - List of all accumulated periods available.
The LOV is restricted to the role and
salesperson.

Y ?

Currency Type Functional or salesperson currency. Default to
the
salesperson
currency.

Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Compensation Plan LOV - All of the compensation plans restricted
by the information entered in all the other

Y ?
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parameter fields.
Plan Element LOV - All of the plan elements restricted by the

information entered in the other parameter
fields especially the compensation plan
parameter field.

Y ?
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Data

Column Descriptions

The following table describes each column to be included in the Performance Details Report.

Column Title Description Value
Length

Column Name/Formula

Summary <Plan
Element> Measure
Amount

The selected measure amount earned by the salesperson
during this period for the stated plan element.

10 ?

Summary  <Plan
Element> Quota
Achievement %

The percentage of quota achieved for the stated
salesperson during this period for the stated plan
element.

10 ?

Summary <Plan
Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated plan
element.

10 ?

Details <Revenue
Class>  (In <Credit
Type> <Measure>
Current

The selected measure amount earned by the salesperson
during this period for the stated revenue class which has
been assigned to the selected plan element.

10 ?

Details <Revenue
Class> (In <Credit
Type>) <Measure>
<Interval Name>

The selected measure amount earned by the salesperson
during the relevant interval for the stated revenue class
which has been assigned to the selected plan element.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Quota
Current

The period quota target for the revenue class assigned to
the selected plan element for the selected salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Quota
<Interval Name>

The relevant interval quota target for the revenue class
assigned to the selected plan element for the selected
salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>)  Quota
Achievement %
Current

  The percentage of quota achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the current period.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Quota
Achievement %
<Interval Name>

The percentage of quota achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the relevant interval.

10 ?
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Column Title Description Value
Length

Column Name/Formula

Details <Revenue
Class> (In <Credit
Type>) Amount to
Reach Quota Current

The amount outstanding required to reach the stated
revenue classes quota target set for the current period
and for the selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Amount to
Reach Quota
<Interval Name>

The amount outstanding required to reach the stated
revenue classes quota target set for the relevant interval
and for the selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal Current

The period goal  target for the revenue class assigned to
the selected plan element for the selected salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal
<Interval Name>

The relevant interval goal  target for the revenue class
assigned to the selected plan element for the selected
salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal
Achievement %
Current

The percentage of goal achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the current period.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal
Achievement %
<Interval Name>

The percentage of goal achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the relevant interval.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Amount to
reach Goal Current

The amount outstanding required to reach the stated
revenue classes goal target set for the current period and
for the selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In  <Credit
Type>) Amount to
reach Goal <Interval
Name>

The amount outstanding required to reach the stated
revenue classes goal target set for the relevant interval
and for the selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In  <Credit
Type>) Amount
Pending Current

The amount pending for the selected salesperson during
this period with the stated revenue class assigned to the
selected plan element.

10 ?

Details <Revenue
Class> (In  <Credit
Type>) Amount
Pending <Interval
Name>

The amount pending for the selected salesperson during
the relevant interval with the stated revenue class
assigned to the selected plan element.

10 ?
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Layout/Graphics
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SUMMARY (Current Period) Measure Amount Quota Achievement
%

Goal Achievement
%

<Plan Element name 1> 400,000 28% 47%

DETAILS
<Revenue Class Name 1> (In <Credit type>)

Current <Interval name>
<Measure> 200,000 800,000
Quota 1,000,000 3,000,000
Quota Achievement % 20% 27%
Amount to Reach Quota 800,000 2,200,000
Goal 650,000 1,950,000
Goal Achievement % 38% 41%
Amount to Reach Goal 450,000 1,150,000
Amount Pending -200,000 200,000

<Revenue Class Name 2> (In <Credit type>)
Current <Interval name>

<Measure> 200,000 500,000
Quota 400,000 1,200,000
Quota Achievement % 50% 42%
Amount to Reach Quota 200,000 700,000
Goal 400,000 1,100,000
Goal Achievement % 50% 46%
Amount to Reach Goal 200,000 600,000
Amount Pending 100 100
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Performance Details Report (Fiscal View)
This performance report shows details of the Compensation Summary Report and is used primarily by the salesperson and sales manager. It
indicates user defined measures of achievement within revenue class. Users can see both quota and goal achievement.

This report can be accessed through the Compensation Summary and Compensation Trend reports and links further to the Sales Credits report.
The report can be run to show results of the current period and interval to date as well as a fiscal view. When run in fiscal view, the graph shows
only the current period. This report may be combined with the Performance Details report when the report layout is set to ‘YTD vs 12 Months’.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using the
‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’ names. If not
entered the salesperson number must be entered.
Once a value is selected in the salesperson name
field the salesperson numbers should be
automatically populated also.

The person
who has
logged in.

Y NAME

Salesperson Role LOV - All roles available for this salesperson,
user should be able to pick ‘All’, which would
represent a summary of all of their roles
together. This LOV is restricted to the roles
applicable to the salesperson selected.

All Y NAME

Credit Type LOV - List of all the credit types available for
this salesperson. This LOV is restricted to the
appropriate values for the salesperson and role
selected.

Y NAME

Reporting Period LOV - List of all accumulated periods available.
The LOV is restricted to the role and
salesperson.

Y ?

Currency Type Functional or salesperson currency. Default to
the
salesperson
currency.

Y SELECT MEANING FROM
CN_LOOKUPS WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Compensation Plan LOV - All of the compensation plans restricted Y ?
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by the information entered in all the other
parameter fields.

Plan Element LOV - All of the plan elements restricted by the
information entered in the other parameter
fields especially the compensation plan
parameter field.

Y ?
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Data

Column Descriptions

The following table describes each column to be included in the Performance Details Report.

Column Title Description Value
Length

Column Name/Formula

Summary <Plan
Element> Measure
Amount

The selected measure amount earned by the salesperson
during this period for the stated plan element.

10 ?

Summary  <Plan
Element> Quota
Achievement %

The percentage of quota achieved for the stated
salesperson during this period for the stated plan
element.

10 ?

Summary <Plan
Element> Goal
Achievement %

The percentage of goal achieved for the stated
salesperson during this period for the stated plan
element.

10 ?

Details <Revenue
Class>  (In <Credit
Type> <Measure>
<Period>

The selected measure amount earned by the salesperson
during this period for the stated revenue class which has
been assigned to the selected plan element.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Quota
<Period>

The period quota target for the revenue class assigned to
the selected plan element for the selected salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>)  Quota
Achievement %
<Period>

The percentage of quota achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the period.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Amount to
Reach Quota
<Period>

The amount outstanding required to reach the stated
revenue classes quota target set for the period and for
the selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal
<Period>

The period goal  target for the revenue class assigned to
the selected plan element for the selected salesperson.

10 ?

Details <Revenue
Class> (In <Credit
Type>) Goal
Achievement %
<Period>

The percentage of goal achieved for the stated
salesperson  and revenue class assigned to the selected
plan element for the period.

10 ?
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Column Title Description Value
Length

Column Name/Formula

Details <Revenue
Class> (In <Credit
Type>) Amount to
reach Goal <Period>

The amount outstanding required to reach the stated
revenue classes goal target set for the period and for the
selected plan element and salesperson.

10 ?

Details <Revenue
Class> (In  <Credit
Type>) Amount
Pending <Period>

The amount pending for the selected salesperson during
this period with the stated revenue class assigned to the
selected plan element.

10 ?
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SUMMARY (Current Period) Measure
Amount

Quota
Achievement %

Goal Achievement
%

<Plan Element name 1> 400,000 28% 47%

DETAILS
<Revenue Class Name 1>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999

<Measure> 600,000 200,000 0 0 0 0 0 0 0 0 0
Quota 1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
Quota Achievement % 60% 20% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 400,000 800,000 1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
1,000,0

00
Goal 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000
Goal Achievement % 92% 31% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Goal 50,000 450,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000 650,000
Amount Pending 400,000 1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00
1,200,0

00

<Revenue Class Name
2>
(In <credit type>) Apr-1999 May-1999 Jun-1999 Jul-1999 Aug-1999 Sep-1999 Oct-1999 Nov-1999 Dec-1999 Jan-1999 Feb-1999

<Measure> 300,000 200,000 0 0 0 0 0 0 0 0 0
Quota 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000
Quota Achievement % 75% 50% 0% 0% 0% 0% 0% 0% 0% 0% 0%
Amount to Reach Quota 100,000 200,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000
Goal 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000
Goal Achievement %
Amount to Reach Goal 100,000 200,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000 400,000
Amount Pending 100,000 300,000 300,000 300,000 300,000 300,000 300,000 300,000 300,000 300,000 300,000
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Sales Credits Report
This performance report shows all sales credits that make up the commission/bonus amounts. It is the main report used by both salespeople
and compensation analysts, and sales managers also find this report useful. Columns are user defined and can be sorted and sub-totaled based
on user defined criteria.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by using the
‘export to excel function’.
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Parameters

Prompt Choices Available Default
Value

Mandat
ory

LOV - Column
Name/Formula

Reporting Period LOV - List of all accumulated Periods available. Y PERIOD_NAME
Salesperson Name LOV - All the sales persons’ names and the extra choice ‘All’. If not

entered the salesperson number must be entered. Once a value is
selected in the salesperson name field the salesperson number should
be automatically populated also.

All Y NAME

Salesperson Type LOV - List of all the salesperson types available in the selected
period. The user should also be able to pick ‘All’, which would
represent a summary of all their salesperson types together.
Examples are Employee and Other. This LOV is restricted to the
salesperson types applicable to the salesperson and role selected.

All Y TYPE

Sales Role LOV - All roles available for the selected salesperson (if specified)
in the selected period. The user should also be able to pick ‘All’,
which would represent a summary of all their roles together.

All Y NAME

Credit Type LOV - List of all the credit types available for this salesperson. This
LOV is restricted to the appropriate values for the salesperson and
role selected.

Y NAME

Currency Type Functional or Salesperson currency Default to
the
salesperso
n
currency

Y SELECT MEANING
FROM
CN_LOOKUPS
WHERE
LOOKUP_TYPE =
‘CURRENCY_TYPE’

Sort By LOV - All the fields used in this report stated in the data section. N New functionality
Then By LOV - All the fields used in this report except the one stated in the

‘sort by’ parameter. If no value is entered in the ‘sort by’ column
then this parameter should be disabled.

N New functionality

Finally By LOV - All the fields used in this report except the values entered in
the ‘sort by’ and ‘finally by’ parameter fields. If no value is entered
in the ‘then by’ column then this parameter should be disabled.

N New functionality
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Data

Column Descriptions

The following table describes each column to be included in the Sales Credits Report.

Column Title Description Value
Length

Column Name/Formula

Direct Salesperson Name The direct salespersons name 40 DIRECT_SALESREP_NAME
Direct Salesperson Number The direct salespersons number 30 DIRECT_SALESREP_NUMBER
Date The process date for the transaction 11 PROCESSED_DATE
Transaction Type The transaction type 22 TRX_TYPE
Customer Name The customer name for the

transaction. Drill down to customer
details (Ship-to, bill-to)

35 CUSTOMER_NAME (This should
drill down)

Order Date The order date for the transaction. 11 ORDER_DATE
Order Number The order number for the

transaction
15 ORDER_NUMBER

Invoice Date The invoice Date for the transaction 11 INVOICE_DATE
Invoice Number The Invoice Number for the

transaction
15 INVOICE_NUMBER

Quantity Quantity for the transaction 6 QUANTITY
Transaction Amount The transaction amount 15 TRANSACTION_AMOUNT
Currency The currency for this transaction 15 CURRENCY_CODE
Exchange Rate The exchange rate for the

transaction
10 EXCHANGE_RATE

Functional Amount The functional amount for the
transaction

15 FUNCTIONAL_AMOUNT

Revenue Class The revenue class name for the
transaction

30 REVENUE_CLASS

Sales Credits The Commissionable Amount for
the transaction

20 COMMISSIONABLE_AMOOUN
T

Commission/Bonus Amount The Commission/Bonus Amount for
the transaction

20 COMMISSION_AMOUNT
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Example One:

Direct Salesperson
Name

Direct
Salesperson
Number

Date Transaction Type Customer
Name

Order Date Order
Number

Invoice Date Invoice
Number

Quantity Transaction
Amount

Currency Exchange
Rate

Functional
Amount

Bob Wiley 11 15-Jan-1999 Manual Transaction Chips Ltd 15-Jan-1999 87899 17-Jan-
1999

12314 4 75,000 ? 75,000

Barry Lewis 44 15-Jan-1999 Manual Transaction IBM 15-Jan-1999 54366 17-Jan-
1999

76424 3 15,000 ? 15,000

Delores Smith-Jones 45 15-Jan-1999 Manual Transaction Chips Ltd 15-Jan-1999 31411 17-Jan-
1999

21663 6 25,000 ? 25,000

Elaine Manley 46 15-Jan-1999 Manual Transaction Chips Ltd 15-Jan-1999 34543 17-Jan-
1999

68098 96 78,520 ? 78,520

Howard Sprague 47 15-Jan-1999 Manual Transaction ICL 15-Jan-1999 43531 17-Jan-
1999

32901 4 45,000 ? 45,000

Jerrold Feinberg 48 15-Jan-1999 Manual Transaction Chips Ltd 15-Jan-1999 56767 17-Jan-
1999

60925 4 150,000 ? 150,000

Lisa Douglas 49 15-Jan-1999 Manual Transaction IBM 15-Jan-1999 88142 17-Jan-
1999

24763 4 45,000 ? 45,000

Pat Murphy 50 15-Jan-1999 Manual Transaction Chips Ltd 15-Jan-1999 53784 17-Jan-
1999

73189 4 3,000 ? 3,000

Grand Total 436,520 436,520
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Example Two:
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Direct Salesperson
Name

Direct
Salesperson
Number

Date Transaction Type Ship to
Customer
Name

Bill to
Customer
Name

Order Date Order
Number

Invoice Date Invoice
Number

Quantity Transaction
Amount

Currency Exchange
Rate

Bob Wiley 11 15-Jan-99 Manual Transaction Chips Ltd Chips Ltd 15-Jan-99 87899 17-Jan-99 12314 4 75,000 ?
Delores Smith-Jones 48 15-Jan-99 Manual Transaction Chips Ltd Chip Set Ltd 15-Jan-99 56767 17-Jan-99 60925 4 150,000 ?
Elaine Manley 50 15-Jan-99 Manual Transaction Chips Ltd Chip Set Ltd 15-Jan-99 53784 17-Jan-99 73189 4 3,000 ?
Jerrold Feinberg 45 15-Jan-99 Manual Transaction Chips Ltd Chips Ltd 16-Jan-99 31411 17-Jan-99 21663 6 25,000 ?
Pat Murphy 46 15-Jan-99 Manual Transaction Chips Ltd Chips Ltd 16-Jan-99 34543 17-Jan-99 68098 96 78,520 ?

Subtotal By
Customer Name

331,520

Lisa Douglas 49 15-Jan-99 Manual Transaction IBM IBM 16-Jan-99 88142 17-Jan-99 24763 4 45,000 ?
Barry Lewis 44 15-Jan-99 Manual Transaction IBM IBM 15-Jan-99 54366 17-Jan-99 76424 3 15,000 ?

Subtotal By
Customer Name

60,000

Howard Sprague 47 15-Jan-99 Manual Transaction ICL ICL 15-Jan-99 43531 17-Jan-99 32901 4 45,000 ?

Grand Total 436,520
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Operational Reports

Salespeople Hierarchy Report
This report displays any salespeople hierarchy within an organization at any moment in time as specified by the user. The
compensation group name fields link to the Compensation Group Hierarchy Report. The salesperson(s) fields link to the Compensation
Summary Report.

Users can enter messages that will appear at the bottom of a report.

The search criteria item is displayed in a different color in the report results so that it stands out from the rest of the search items.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’
names. If not entered the
salesperson number must be
entered. Once a value is selected in
the salesperson name field the
salesperson number should be
automatically populated also.

Y NAME

Salesperson Number LOV - All the salespersons’
numbers. If not entered the
salesperson name must be entered.
Once a value is selected in the
salesperson number field the
salesperson name should be
automatically populated also

Y EMPLOYEE_NUMBER

Compensation Group
Name

LOV - All the compensation
group names and the extra choice
‘ALL’. - The LOV should be
restricted to the Compensation
Groups assigned to the salesperson
indicated by the salesperson
parameters.

ALL Y NAME

Effective Date No LOV - The calendar  feature
should be used.

Current Date Y CALANDER WIDGET
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Data

Column Descriptions

The following table describes each column to be included in the Salespeople Hierarchy Report.

Column Title Description Value
Length

Column Name/Formula

Compensation Group
Name

The salespersons
compensation group.

30 NAME

Manager Name
/Number/Type

The Manager name
concatenated with the
salesperson number
and resource type.
LOV from the
system..

50 NAME || EMPLOYEE_NUMBER || TYPE

Salesperson
Name/Number/Type

The salesperson name
concatenated with the
salesperson number
and resource type.
LOV from the system.

50 NAME || EMPLOYEE_NUMBER || TYPE

Sales Role The role assigned to
the salesperson in the
selected analyst group.

20 NAME

Effective Dates The salesperson
effective date from
field concatenated
with the effective date
to field.

30 START_DATE_ACTIVE ||
END_DATE_ACTIVE
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Example One :

Compensati
on Group
Name

Manager
Name/Number/Type

Salesperson Name/Number/Type Sales Role Effective Dates

Oregon Thomas Selleck, 25,
Employee

Regional Manager 01-Jan-1999 - 28-Feb-
2000

Lisa Douglas, 2500, Employee Salesrep 1 01-Jan-1999 - 28-Feb-
2000

Howard Sprague, 15000, Employee Salesrep 2 01-Jan-1999 - 28-Feb-
2000

Delores Smith-Jones, 18085,
Employee

Salesrep 3 01-Jan-1999 - 28-Feb-
2000

Washington Thomas Selleck, 25,
Employee

Regional Manager 01-Jan-1999 - 28-Feb-
2000

Barry Lewis, 7500, Employee Salesrep 1 01-Jan-1999 - 28-Feb-
2000

Suzanne Green, 10007, Employee Salesrep 2 01-Jan-1999 - 28-Feb-
2000

Pat Murphy, 5845, Contractor Salesrep 3 01-Jan-1999 - 28-Feb-
2000
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Timothy Cleary, 6950, Employee Salesrep 4 01-Jan-1999 - 28-Feb-
2000

Example Two :

Compensati
on Group
Name

Manager
Name/Number/Type

Salesperson Name/Number/Type Sales Role Effective Dates

Oregon Thomas Selleck, 25,
Employee

Regional Manager 01-Jan-1999 - 28-Feb-
2000

Lisa Douglas, 2500, Employee Salesrep 1 01-Jan-1999 - 28-Feb-
2000

Howard Sprague, 15000, Employee Salesrep 2 01-Jan-1999 - 28-Feb-
2000

Delores Smith-Jones, 18085,
Employee

Salesrep 3 01-Jan-1999 - 28-Feb-
2000
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Exception Reports

Payment Hold Report
This is a standard concurrent manager report and will be most useful for the compensation analyst or superuser.

You can enter messages that will appear at the bottom of a report. You can export the information for some fields of this report by
using the ‘export to excel function’.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Salesperson Name LOV - All the sales persons’
names and the extra choice ‘All’.
Once a value is selected in the
salesperson name field the
salesperson number should be
automatically populated also.

All Y NAME

Hold Reason No LOV N



Exception Reports
SCReprts.doc  (v. 1.0) Oracle/Client Confidential - For internal use only

4

Data

Column Descriptions

The following table describes each column to be included in the Payment Hold Report.

Column
Title

Description Value
Length

Column Name/Formula

Salesperson
Name

The salesperson
name(s)  Salesperson
Worksheet

40 NAME

Salesperson
Number

The salesperson
number(s)  Salesperson
Worksheet

10 EMPLOYEE_NUMBER

Hold Reason The reason that the
transaction has been put
on hold.

80 HOLD_REASON
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Layout/Graphics

Salesperson Name Salesperson Number Hold Reason
Bob Whiley 11 Holding for non-performance
Barry Lewis 44 Terminated employee - other reasons
Delores Smith-Jones 45 Pending further investigation
Elaine Manley 46 Pending further investigation
Howard Sprague 47 Inter-company pending correction
Jerrold Fienberg 48 Holding for non performance
Lisa Douglas 49 Pending further investigation
Pat Murphy 50 Holding for non performance
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Known Where Conditions

Where the HOLD_PAYMENT field in the CN_SALESREP_DETAILS
view is set to ‘Y’. The SALESREP_ID field in the
CN_SALESREP_DETAILS view is equal to the SALESREP_ID field in
the CN_SALESREPS view.
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Classification Rules Report
This report lists all classification rules and will be useful for a system
administrator or superuser. You can export the information for some fields of
this report by using the ‘export to excel function’.

Query results show parent rules/children rules of the search criteria (rule
name) all the way to the top/bottom of the hierarchy (Direct path). The
search criteria phrase is displayed in a different color in the report results so
that it stands out from the rest of the rule names. The Revenue class and
expression for a selected rule name are displayed in a different color.

Parameters

Prompt Choices Available Default
Value

Mandatory LOV - Column
Name/Formula

Rule Name LOV - All the rule names and the
extra choice ‘All’.

All Y NAME

Effective Date No LOV - The calendar feature
should be used.

Current Date Y CALENDAR WIDGET

Ruleset Name LOV - All the rule names and the
extra choice ‘All’.

All Y

Data

Column Descriptions

The following table describes each column to be included in the
Classification Rules Report.

Column Title Description Value
Length

Column Name/Formula

Rule Name Display the classification rule name. Sort by
parent rule name then alphabetically by rule
name.

20 NAME

Revenue Class Display the revenue class name assigned to
the classification rule.

20 NAME

Expression Display the expression that is used to
classify the individual rule.

70 EXPRESSION?
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Layout/Graphics

Example One:

Rule Name Revenue Class Expression
All All When status = Y

Hardware Hardware When package_type = HW
Services Services When package_type = SV

Consulting Consulting When product_code = CONSULTING
Support Support When product_code = SUPPORT and 

to ORACLE
Training Training When product_code = TRAINING
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Example Two:

Rule Name Revenue Class Expression
All All When status = Y

Services Services When package_type = SV
Consulting Consulting When product_code = CONSULTING
Support Support When product_code = SUPPORT and 

to ORACLE
Training Training When product_code = TRAINING
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